What's Up Gold

Software Version 8

Ipswitch, Inc.   Phone:  (781) 676- 5700
81 Hartwell Ave   Fax: (781) 676- 5710
Lexington, MA 02421- 3127   Web:  http://www.ipswitch.com

Copyright © 1995- 2001 by Ipswitch, Inc. All rights reserved.

IMail, WhatsUp, WhatsUp logo, WS_FTP, WS_FTP logo, Ipswitch, ±×¸®°í Ipswitch logo
Ã¬ Ípswitch, Inc.ÀÇ µî·Ï»óÇ¥ÀÔ´Ï´Ù.
Preface
What This Package Includes
Ipswitch Products
Introduction
What is WhatsUp Gold?
Overview of Basic Features
Using the Web interface
Mapping the Network
Monitoring the Network
Getting information from the Network Map
Application and Map State Icons
Getting status for a device
Getting Information via Notifications
Logs and Reports
Additional Features
What’s New in Version 8.0
System Requirements
Installation
Trying WhatsUp Gold on Your Network
Creating a New Network Map
Adding a File Server
Initiating Monitoring
Running WhatsUp Gold as an NT Service
Starting and Stopping the NT Service
Creating Network Maps
Way to Map Your Network
Discover and Map Network Devices
Mapping a Hierarchical Network - SNMP
Using SmartScan
Results of the SmartScan
SNMP Manageable Devices
Mapping a Flat Network
Results of the Scan
Discover devices from Network Neighborhood
Loading a Hosts File
Manually Drawing a Map
Reading a Network Map
Setting Map Polling Properties
Saving and Naming a Network Map
Saving a Context
3. Additional Mapping Techniques.................................
   - Active Discovery of Devices.................................
   - Exporting and Importing Map Data........................
   - (Changing the Map Database Format).....................
   - (Traceroute Mapping)...........................................
   - (Mapping Link Lines)...........................................
   - (Using Custom Devices).......................................
   - (Creating a Subnet)............................................
   - (Master Switches and Misc. Settings)....................

4. Editing a Network Map............................................
   - (Getting In and Out of Edit Mode)........................
   - (Tips for Making a Map Easier to Read)...................
   - (Draw Toolbar)..................................................
   - (Keeping Tools Active).....................................
   - (Drawing).........................................................
   - (Attached Lines)...............................................  
   - (Setting the Map Display)..................................
   - (Optional Map Views)........................................
   - (Device States).................................................
   - (Creating Text Captions)...................................
   - (Using Dependency Arrows).................................
   - (Arranging the Toolbars)...................................
   - (Galleries)......................................................

5. Working with Devices.............................................
   - (The Polling Method)...........................................
   - (Defining General Properties)..............................
   - (Setting Up Monitoring).....................................
   - (Using the Right Mouse Menu).............................
   - (Using Quick Status).........................................
   - (Adding a Command to the Right Mouse Menu)........
   - (Adding Custom Menus to a Group of Devices)........
   - (Program Variables).........................................
   - (Customizing Device Types)................................
   - (Creating a Device Type)...................................
   - (Changing the Double-Click Action for a Customized Devices) ..................................................
   - (Running a script or program for customized devices) ..................................................
   - (Add Web Menu Items to Devices) ........................
   - (Using the Customized Devices on a Map)..............
   - (Scanning and Mapping a Device).........................
6  Monitoring Services

- TCP/IP (Monitoring Standard TCP/IP Services)
- TCP/IP (Defining a Custom TCP/IP Service)
- Script Syntax
- SimpleExpect Keywords
- Flow Control Keywords
- Rules Expressions Text and Quantifiers Tables
- Testing a Rules Expression
- Defining an SNMP Object to Monitor
- Custom Services API

7  Monitoring Events

- Configuring the Event Servers
- What is an Event Server?
- Event Library
- Adding Events to the Events Library
- Defining an SNMP Trap Event
- Defining a Syslog Event
- Defining a Windows Log Event
- Using Events for the First Time–A Simulation
- Adding an Event to a Device
- Associating an Alert to your Event
- Event Visual Indicator
- Manually Triggering your Event

8  Notifications

- Setting Up Notifications
- Defining Beeper Notifications
- Defining Pager Notifications
- Defining SMS Notifications
- Defining E-mail Notifications
- Defining Service Restart Notification
- Defining Sound Notifications
- Defining Syslog Notifications
- Defining Text to Speech Notification
- Defining WinPopup Notifications
- Defining Group Notifications
- Defining Program Notifications
- Event Name Information
- More details for On Event - regarding SNMP Trap events
- Notification Message Variables
- The Event Notification Variable %(*)
Notifications (Testing the Notifications) ..............................................................................................................
Notifications (Setting Up a Voice Modem) ..............................................................................................................
Notifications (Defining Voice Notifications) ..........................................................................................................
notiﬁcation (Creating a voice notiﬁcation) .............................................................................................................
Alerts (Assigning Alerts to Device) .....................................................................................................................
Alerts (Using the Alerts Dialog) ...........................................................................................................................
Alerts (Assigning Alerts to Selected Devices) ........................................................................................................
Notification (Assigning a Notification to an Alert) .................................................................................................
Alerts (Editing Alerts) ...........................................................................................................................................

9 (Working from the console) ................................................................................................................................

9 (Opening Network Maps) ....................................................................................................................................
9 (Starting and Stopping Polling) .............................................................................................................................
9 (To Initiate Automatic Polling) ............................................................................................................................
9 (To Stop Automatic Polling) ..................................................................................................................................
9 (To check a Device) ..............................................................................................................................................
9 (Reading the Network Map) .................................................................................................................................
9 (Receiving the Alarms) ........................................................................................................................................
9 (Acknowledge Alerts) ..........................................................................................................................................  

Status Window (Using the Status Window) ..............................................................................................................

Dependencies (Viewing and Changing Dependencies) ............................................................................................
Up Down Dependencies (Setting Up and Down Dependencies) ............................................................................
Viewing the Polling Statistics ..................................................................................................................................
Viewing Active Notifications ...................................................................................................................................
Using the Mini Status View ....................................................................................................................................

10 (Logging and Reporting) ................................................................................................................................

WhatsUp Gold Syslog ...............................................................................................................................................  

Activity (Logging and Reporting Activities) ............................................................................................................
Activity Log (Actions that Trigger Entries in the Activity Log File) ......................................................................
Activity (Changing How Activities Are Logged) ....................................................................................................
Outage (Creating an Outage Report) .....................................................................................................................
Debug Log Information ............................................................................................................................................
Using the Command Line for Outage Reports ..........................................................................................................  

Basic Command Syntax .........................................................................................................................................
(Examples) .............................................................................................................................................................
Return Codes ............................................................................................................................................................

Logging and Reporting Polling Statistics ................................................................................................................
(The Polling Statistics) ............................................................................................................................................
Changing Statistics Logging .....................................................................................................................................
Creating Reports on Polling Statistics ....................................................................................................................
Exporting Raw Data ................................................................................................................................................
Statistics Report Legend .........................................................................................................................................
No text content available in the image.
<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>SNMP - Device SNMP Info (Device SNMP Info)</td>
<td>1</td>
</tr>
<tr>
<td>MIB - MIB Viewer</td>
<td>2</td>
</tr>
<tr>
<td>SNMP - SNMP Trap Event, Trap Notification (Adding, Editing, and Deleting SNMP Objects)</td>
<td>3</td>
</tr>
<tr>
<td>SNMP - Viewing Item Values</td>
<td>4</td>
</tr>
<tr>
<td>SNMP - Editing Item Properties</td>
<td>5</td>
</tr>
<tr>
<td>SNMP - Deleting Items from the Graph</td>
<td>6</td>
</tr>
<tr>
<td>SNMP - Saving and Opening Graph Files</td>
<td>7</td>
</tr>
<tr>
<td>SNMP - Editing Graph Properties</td>
<td>8</td>
</tr>
<tr>
<td>SNMP Trap Events - Receiving SNMP Traps</td>
<td>9</td>
</tr>
<tr>
<td>SNMP Trap Events - Setting Up SNMP Trap Events</td>
<td>10</td>
</tr>
<tr>
<td>SNMP Trap Events - Assigning SNMP Trap Events to a Device</td>
<td>11</td>
</tr>
<tr>
<td>SNMP Trap Events - Setting Up Notifications for SNMP Trap Events</td>
<td>12</td>
</tr>
<tr>
<td>SNMP - Viewing Trap Log Entries</td>
<td>13</td>
</tr>
<tr>
<td>SNMP - Monitoring SNMP Service</td>
<td>14</td>
</tr>
<tr>
<td>Starting the SNMP Graphing Utility</td>
<td>15</td>
</tr>
<tr>
<td>SNM P - Graphing SNMP Values</td>
<td>16</td>
</tr>
<tr>
<td>Using Network Tools</td>
<td>17</td>
</tr>
<tr>
<td>Using Format, Copy, and Print Functions</td>
<td>18</td>
</tr>
<tr>
<td>Display Device Information Info Tool</td>
<td>19</td>
</tr>
<tr>
<td>Checking a Web Access HTML Tool</td>
<td>20</td>
</tr>
<tr>
<td>Synchronizing Time</td>
<td>21</td>
</tr>
<tr>
<td>Ping Tool</td>
<td>22</td>
</tr>
<tr>
<td>TraceRoute Tool</td>
<td>23</td>
</tr>
<tr>
<td>Lookup Tool</td>
<td>24</td>
</tr>
<tr>
<td>Finger Tool</td>
<td>25</td>
</tr>
<tr>
<td>Whois Tool</td>
<td>26</td>
</tr>
<tr>
<td>LDAP Tool</td>
<td>27</td>
</tr>
<tr>
<td>Quotations - Quote Tool</td>
<td>28</td>
</tr>
<tr>
<td>Display Device Information Info Tool</td>
<td>29</td>
</tr>
<tr>
<td>Using Format, Copy, and Print Functions</td>
<td>30</td>
</tr>
<tr>
<td>Monitoring SNMP Service</td>
<td>31</td>
</tr>
<tr>
<td>Receiving SNMP Traps</td>
<td>32</td>
</tr>
<tr>
<td>Setting Up SNMP Trap Events</td>
<td>33</td>
</tr>
<tr>
<td>Assigning SNMP Trap Events to a Device</td>
<td>34</td>
</tr>
<tr>
<td>Setting Up Notifications for SNMP Trap Events</td>
<td>35</td>
</tr>
<tr>
<td>Viewing Trap Log Entries</td>
<td>36</td>
</tr>
<tr>
<td>Monitoring SNMP Service</td>
<td>37</td>
</tr>
<tr>
<td>SNMP - Display Device Information Info Tool</td>
<td>38</td>
</tr>
<tr>
<td>Using Format, Copy, and Print Functions</td>
<td>39</td>
</tr>
<tr>
<td>Display Device Information Info Tool</td>
<td>40</td>
</tr>
<tr>
<td>Using Format, Copy, and Print Functions</td>
<td>41</td>
</tr>
<tr>
<td>Monitoring SNMP Service</td>
<td>42</td>
</tr>
<tr>
<td>Receiving SNMP Traps</td>
<td>43</td>
</tr>
<tr>
<td>Setting Up SNMP Trap Events</td>
<td>44</td>
</tr>
<tr>
<td>Assigning SNMP Trap Events to a Device</td>
<td>45</td>
</tr>
<tr>
<td>Setting Up Notifications for SNMP Trap Events</td>
<td>46</td>
</tr>
<tr>
<td>Viewing Trap Log Entries</td>
<td>47</td>
</tr>
<tr>
<td>Monitoring SNMP Service</td>
<td>48</td>
</tr>
</tbody>
</table>
(Preface)


(What This Package Includes)

WhatsUp Gold CD
License agreement
WhatsUp Gold User’s Guide

(Ipswitch Products)

WS_FTP™ Pro FTP Client

WS_FTP Pro is a powerful FTP client.  WS_FTP Pro includes Find Utility, Scripting Utility, and Synchronize Utility.

WS_FTP Server


Interrupt feature.
IMail Server

IMail Server 是一个邮件服务器软件，它支持 SMTP(Simple Mail Transfer Protocol)、POP3(Post Office Protocol, Version3)、IMAP4(Internet Message Access Protocol 4)和其他邮件协议。IMail Server 是一个集成的邮件系统，它支持 IMAP、POP3 和 SMTP 协议。

Windows NT, Windows 2000

WS_Ping ProPack™

WS_Ping ProPack 是一个网络性能测试工具，它支持多种网络测试功能，如 Info、Time、HTML、Ping、TraceRoute、Lookup、Finger、Whois、LDAP、Quote、Scan、SNMP、WinNet、Throughput 等。WS_Ping ProPack 支持 Windows 95, Windows 98, Windows NT, Windows 2000。
1 Introduction

WhatsUp Gold is a network monitoring and management tool that can be used to monitor the status of networked devices, such as servers, workstations, switches, and routers. It can also be used to monitor network services, such as HTTP, HTTPS, SMTP, and DNS. WhatsUp Gold can be configured to monitor a wide range of network protocols, including TCP/IP, SNMP, NetBIOS, and IPX.

Note: To access the release notes, go to Programs->WhatsUp Gold->WhatsUp Gold Release Note.

WhatsUp Gold? (What is WhatsUp Gold?)

WhatsUp Gold is a network monitoring and management tool that can be used to monitor the status of networked devices, such as servers, workstations, switches, and routers. It can also be used to monitor network services, such as HTTP, HTTPS, SMTP, and DNS. WhatsUp Gold can be configured to monitor a wide range of network protocols, including TCP/IP, SNMP, NetBIOS, and IPX.

Note: To access the release notes, go to Programs->WhatsUp Gold->WhatsUp Gold Release Note.

WhatsUp Gold is a network monitoring and management tool that can be used to monitor the status of networked devices, such as servers, workstations, switches, and routers. It can also be used to monitor network services, such as HTTP, HTTPS, SMTP, and DNS. WhatsUp Gold can be configured to monitor a wide range of network protocols, including TCP/IP, SNMP, NetBIOS, and IPX.

Note: To access the release notes, go to Programs->WhatsUp Gold->WhatsUp Gold Release Note.

User's Guide

WhatsUp Gold
Overview of Basic Features

WhatsUp Gold is a high-end monitoring tool that supports various notification methods. It offers various views such as Top View, Detail View, Map View, Summary View, Device View, Activity Log, Statistics View, Outage Report, and Statistics Report.

Using the Web interface

WhatsUp Gold supports the Web interface on ports 80 and 443. It also supports mapping the network. The network can be mapped using "discover and map" methods. The supported methods are:

- Windows
- SNMP
- IP
- Hosts
“discovery and map” TCP/IP, NetBIOS, IPX. The "discovery and map" includes top-level structures.

"discovery and map" “active discovery” includes top-level information.

(Monitoring the Network)

WhatsUp Gold includes monitoring of network activity, including "poll" and "check" actions.
**Note**

WhatsUp Gold Monitor Mode Edit Mode. Monitor Mode

Getting information from the Network Map

Active discovery indicator
Map Properties-> Network “Active discovery”

Active discovery indicator
Map Properties-> Network “Active discovery”

Chapter 4: Editing Network Maps

Getting information from the Network Map

(Setting Map Colors)

(Application and Map State Icons)

(Getting status for a device)

Quick Status (up-to-the-minute status)
Getting Information via Notifications

Notification pooling, WhatSUP Gold (beeper), pager (pooling) NT, Windows. Getting information via notifications (pooling), NT, Windows. Getting information via notifications (pooling), NT, Windows. "Chapter 8: Setting Up Notifications"

Logs and Reports

WhatSUP Gold: logs, reports: 

- Logs and reports
- IP address, network

Performance Graphs. Logs and reports, whatSUP Gold: logs, reports.

Outage Reports. Logs and reports, whatSUP Gold: logs, reports.

Statistics Reports. Logs and reports, whatSUP Gold: logs, reports. "10 Logs and Reports"
(Additional Features)

- SNMP – WhatsUp Gold supports SNMP v1, v2, and v3. SNMP view includes MIB, MIB threshold, MIB viewer, and "SNMP Viewer".

- Customer Services - TCP and UDP communicate. WhatsUp Gold supports SNMP and MIB threshold.

- Extensibility – WhatsUp Gold supports COM add-ins (auto discovery) and non-TCP/IP add-ins.

---

Note: "Custom Service API".

---

8.0 (What’s New in Version 8.0?)

WhatsUp Gold Version 8...
What'sUP Gold, SNMP performance report: "event" or "success". TCP/UDP flow control: "error" or "success".

**User's Guide**

What'sUP Gold
**(System Requirements)**

WhatsUp Gold® requires the following system environment:

- **Intel Pentium®**
- **30MB** hard drive (100MB)
- **64MB** RAM (256MB)
- **Windows NT 4.0(SP6)**, **Windows 2000(SP2)**, **Windows 98**, **Windows ME**, **Windows XP**
- **TCP/IP**
- **Performance Graphs**
  - Microsoft Open Database Connectivity (ODBC)

**ODBC** is the standard way of accessing a relational database, and **WhatsUp Gold**™ uses ODBC to communicate with your ODBC-compliant databases.

**ODBC** must be installed in your system. You can download a free version of ODBC from Microsoft’s website.


Additionally, **IPX** needs to be installed, and **WhatsUp Gold**™ uses Microsoft NWLink IPX/SPX Compatible Transport. You can configure this in the **Network Neighborhood** or by using the **IPX/SPX-compatible Transport** in the **Network Connections** menu.

**Import devices from your registry** and **Discover Devices from your Network Neighborhood** are two useful features in **WhatsUp Gold**.
(Upgrading)

WhatsUp Gold 

- Upgrade to the latest version of WhatsUp Gold. The upgrade process should take around 30 minutes, depending on your system.

- Ensure that you have backed up your current configuration.

- Uninstall the previous version of WhatsUp Gold.

- Install the new version of WhatsUp Gold.

(Installation)

WhatsUp Gold 

1. Insert CD, CD_ROM, or DVD.

- Copy files to your hard drive. 

- Run AutoRun.exe from your CD.

- Navigate to the installation directory, typically C:\Program Files\WhatsUp Gold\.

- Run wugoldec.exe to install the plug-in.

Plug-In: Visit the Ipswitch website for more information: http://www.ipswitch.com/Support/whatsup/plugins.html

2. Configure WhatsUp Gold. 

- Open world.wup and configure the settings as needed.

- Ensure that Microsoft’s Open Database Connectivity (ODBC) is set up properly. 

Performance Graphs is set up properly.
Performance Graphs ของผู้ใช้ ODBC โดยทั่วไป แต่เฉพาะในกรณีที่มีการใช้ ODBC.

1. **NO** ใช้ ODBC.

2. **ODBC** **Requirement** (ODBC **Requirement** "(System Requirement)").

3. **WhatsUp Gold** ใช้ ODBC.

---

**Trying WhatsUp Gold on Your Network**

จัดการและตรวจสอบเครื่องมือของเครือข่าย ผ่านWhatsUp Gold.

**Creating a New Network Map**

1. **File** **New Map Wizard**.

2. **Create a blank map**. WhatsUp Gold.

3. **Edit tab**.

4. **Workstation** (Device pool).

5. **button**.
6 General Display Name

ConsoleTest

WhatsUp Gold

Note

7 Monitor

Monitor This Device

8 Alerts

Enable alerts

Add

Alerts

(Adding a File Server)
3 General, Display Name: Server.

4 IP Address, Host Name, Domain Name Server.

Note: Do not enter domain name stack.

5 Monitor This Device.

6 Alerts, Enable alerts, Add. Sound: Default, OK. OK.

7 File: Save As. MyTestMap.wup.

(Initiating Monitoring)

1 Map tab: Edit Mode, Monitor Mode.

2 Check button.

User's Guide

WhatsUp Gold
NT [시스템] WhatsUp Gold [서비스] (RunningWhatsUp Gold as an NT Service)

Windows NT 4.0 [시스템] WhatsUp Gold [서비스] (normal operating mode)로 설치 후 다음과 같이 설정할 수 있습니다:

-WhatsUp Gold [웹 인터페이스]로 인터넷에서 활성화할 수 있습니다.

NT [시스템] 설정을 위한 한계:


2. “Setting Up to Run as an NT Service”를 선택해주세요.

3. “Starting and Stopping the NT Service”를 선택해주세요.

NT [시스템] 설정을 위한 한계 (Setting Up to Run as an NT Service)

Windows NT (normal operating mode)로 활성화한WhatsUp Gold 서비스는 다음과 같이 설정할 수 있습니다.

Startup  (Configure -> Program Options -> Startup)  Map
Names. Open maps on startup Map Names Add Delete.
Note:  (Configure->Web Server->General)  Map Directory
(Configure->Web Server->General).

Note

(Configure ->Web Server-> Users). Enable Web Server "[] 11 " Working From a Web Browser[].

WhatUp Gold NT normal operating mode "[permission) (General -> Users  "[].

WhatUp Gold NT (Starting and Stopping the NT Service)

1. DOS  .
2. WhatUp Gold  .

wugsvc -install

WhatUp Gold NT DOS .
1. DOS _UPLOAD WhatsUp Gold £²£µ µð·ºÅ͸®·Î. 

2. ¼³Ä¡Çϰí : wugsvc -remove

**Note** ¼³Ä¡Çϰí WhatsUp Gold ÀÚü¸¦ °ÍÀÌ ¾Æ´Ï¶ó´Â À¯ÀÇÇϽʽÃ.
2  Creating Network Maps

WhatsUp Gold provides a comprehensive set of tools to help you create detailed network maps. With WhatsUp Gold, you can easily customize your network maps to suit your needs.

- Customize your network maps using the powerful customization tools provided by WhatsUp Gold.
- Edit Mode allows you to make adjustments to your network maps on the fly.

Way to Map Your Network

Creating detailed network maps is essential for managing and monitoring your network. WithWhatsUp Gold, you can create maps that accurately reflect the structure of your network.

![Network Map Example](image)

User's Guide

WhatsUp Gold
Discover and Map network devices - 

*WhatsUp Gold* 

- 

**SmartScan** - 

**Discover your network using ICMP** - 

**Discover devices from your 'Network Neighborhood'** - 

**Import devices from a hosts file** - 

**Traceroute** - 

**File -> New Map Wizard** - 

*WhatsUp Gold*
Discover and Map (Discover and Map Network Devices)

Discover and Map devices across your network and create accurate network diagrams.

Discover and Map

1. **File New Map Wizard**

2. **Discover and map network devices**

3. **Discover your network with SNMP SmartScan**

User's Guide

WhatsUp Gold
SNMP Scanning.

Note SmartScan and discovery. SmartScan discovery.

Discover your network using ICMP. Internet Control Message Protocol (ICMP). Discover Devices.

Discover devices from your Network Neighborhood. Microsoft Windows Network, WhatsUp Gold. (SNMP SmartScan)

Import devices from your registry. TCP/IP, Microsoft Internet Explorer, Netscape Navigator. (SNMP SmartScan)

Import devices from hosts file. IP address scan. (SNMP SmartScan)

4 Discover your network with SNMP SmartScan, “SNMP SmartScan”.

Discover your network using ICMP. “IP Address Scan”. “Mapping a Flat Network”.

Note Scan Depth Limit scan to IP class of root device SNMP Community.
• Discover devices from your Network Neighborhood, “Network Neighborhood Scan”. Discover devices from your Network Neighborhood.

• Import devices from a hosts file, “Host File Import”. Import devices from a hosts file.

• Import devices from your registry, “TCP/IP Service Scan”. Import devices from your registry.

• ³×Æ®¿öÅ©, “Scan Results”. Scan Results.

5 File  Save  Save As . “Tips for Making a Map Easier to Read”.

(Mapping a Hierarchical Network - SNMP)

 SNMP agent, SmartScan. SmartScan.

Scan Depth  Limit scan to IP address of root device, SNMP Community.

Note (Custom Devices Type). User’s Guide
“Customizing Device Types”

SmartScan using SmartScan FTP, HTTP, SMTP can be configured to detect and map network devices.

SmartScan (Using SmartScan)

SmartScan using SmartScan FTP, HTTP, SMTP can be configured to detect and map network devices. SmartScan top-level (parent map) can be configured to detect and map network devices. SmartScan link can be configured to detect and map network devices. SmartScan using SmartScan can be configured to detect network devices.

1 “SNMP SmartScan” can be configured to detect and map network devices. New Map Wizard can be used. New Map Discover and Map Network Devices can be used. Discover your network with SNMP SmartScan can be used.

- Discover Devices can be used. Discover your network with SNMP SmartScan can be used.

Note SNMP SmartScan can be configured to detect network devices.

2 SmartScan using SmartScan can be configured to detect network devices. Discover Devices can be used. Discover your network with SNMP SmartScan can be used.
3 ³×Æ®¿öÅ©¿¡ Active Discovery ³º·À´Ï´Ù.

4 Filter by Device Type ³º·À´Ï´Ù ¿¹¸¦ ³×Æ®¿öÅ©¿¡ active discovery ³º·À´Ï´Ù. ³º·À´Ï´Ù ³×Æ®¿öÅ©¿¡ Active Discovery ³º·À´Ï´Ù, ³×Æ®¿öÅ©¿¡ active discovery ³º·À´Ï´Ù.

5 ³×Æ®¿öÅ©¿¡ µµ¿¡.

6 ³×Æ®¿öÅ©¿¡ ³º·À´Ï´Ù. ³×Æ®¿öÅ©¿¡ ³º·À´Ï´Ù. ³×Æ®¿öÅ©¿¡ ³º·À´Ï´Ù.

7 File ³º·À´Ï´Ù Save ³º·À´Ï´Ù Save As ³º·À´Ï´Ù ³º·À´Ï´Ù.
Note  "Active Discovery of Devices" ．

SmartScan  (Results of the SmartScan)

"Scanning and Mapping a Device" ．
Flat Network (Mapping a Flat Network)

SNMP (SNMP Manageable Devices)

Scan IP addresses, via the MAP wizard, UPS Gold. Use the MAP wizard to add devices to the map, and to polling them.

Scan FTP, HTTP, SMTP (polling) devices. UPS Gold allows you to add devices to the map and to poll them.

Scan New Map Wizard. New Map

User’s Guide

Solve Hightech! 솔빛 하이테크

SNMP (SNMP Manageable Devices)

Scan IP addresses, via the MAP wizard, UPS Gold. Use the MAP wizard to add devices to the map, and to polling them.

Scan FTP, HTTP, SMTP (polling) devices. UPS Gold allows you to add devices to the map and to poll them.

Scan New Map Wizard. New Map

User’s Guide

Solve Hightech! 솔빛 하이테크

SNMP (SNMP Manageable Devices)

Scan IP addresses, via the MAP wizard, UPS Gold. Use the MAP wizard to add devices to the map, and to polling them.

Scan FTP, HTTP, SMTP (polling) devices. UPS Gold allows you to add devices to the map and to poll them.

Scan New Map Wizard. New Map

User’s Guide

Solve Hightech! 솔빛 하이테크

SNMP (SNMP Manageable Devices)

Scan IP addresses, via the MAP wizard, UPS Gold. Use the MAP wizard to add devices to the map, and to polling them.

Scan FTP, HTTP, SMTP (polling) devices. UPS Gold allows you to add devices to the map and to poll them.

Scan New Map Wizard. New Map

User’s Guide
Discover and Map Network Devices

Discover your network using ICMP.

- Discover Devices, Tools
  Discover your network using ICMP.

2 IP Address Scan

Start Address: 245.245.1.50, End Address: 245.245.10.60
Scan: 245.245.1 245.245.10, 50~60.

3

4
Discover devices from Network Neighborhood

Discover devices from your Network Neighborhood

Windows XP/2000/Windows 95/98/ME/NT4.0/95.0 Scan directory and sub-folders,WhatsUp Gold IP address network devices. The scan scans (active) IP address network devices.

(Results of the Scan)

Scan directory and sub-folders,WhatsUp Gold IP address network devices. The scan scans (active) IP address network devices.

Discover devices from your Network Neighborhood

Discover devices from your Network Neighborhood

1. Discover and Map Network devices. Discover devices from your Network Neighborhood

- File ➤ New Map Wizard
- Discover Devices ➤ Discover devices from your Network Neighborhood

User’s Guide

WhatsUp Gold
Neighborhood ¼±ÅÃÇ₃°ÅΩÅ°.

2 ¼±ÅÃÇ₃°ÅΩÅ° ¼±ÅÃÇ₃°ÅΩÅ°. ¼±ÅÃÇ₃°ÅΩÅ° ¼±ÅÃÇ₃°ÅΩÅ° ¼±ÅÃÇ₃°ÅΩÅ° ¼±ÅÃÇ₃°ÅΩÅ°.

3 ¼±ÅÃÇ₃°ÅΩÅ° ¼±ÅÃÇ₃°ÅΩÅ° ¼±ÅÃÇ₃°ÅΩÅ°.

4 ¼±ÅÃÇ₃°ÅΩÅ° ¼±ÅÃÇ₃°ÅΩÅ° ¼±ÅÃÇ₃°ÅΩÅ°.

5 ¼±ÅÃÇ₃°ÅΩÅ° ¼±ÅÃÇ₃°ÅΩÅ° ¼±ÅÃÇ₃°ÅΩÅ° ¼±ÅÃÇ₃°ÅΩÅ° ¼±ÅÃÇ₃°ÅΩÅ°. ¼±ÅÃÇ₃°ÅΩÅ° ¼±ÅÃÇ₃°ÅΩÅ° ¼±ÅÃÇ₃°ÅΩÅ°.

   WhatsUp Gold ¼±ÅÃÇ₃°ÅΩÅ° Windows ¼±ÅÃÇ₃°ÅΩÅ° ¼±ÅÃÇ₃°ÅΩÅ° ¼±ÅÃÇ₃°ÅΩÅ° ¼±ÅÃÇ₃°ÅΩÅ° ¼±ÅÃÇ₃°ÅΩÅ° ¼±ÅÃÇ₃°ÅΩÅ°.

---

**Note** Network Neighborhood ¼±ÅÃÇ₃°ÅΩÅ° NetWare ¼±ÅÃÇ₃°ÅΩÅ°.

6 ¼±ÅÃÇ₃°ÅΩÅ° ¼±ÅÃÇ₃°ÅΩÅ° ¼±ÅÃÇ₃°ÅΩÅ° ¼±ÅÃÇ₃°ÅΩÅ° ¼±ÅÃÇ₃°ÅΩÅ° ¼±ÅÃÇ₃°ÅΩÅ° ¼±ÅÃÇ₃°ÅΩÅ°.

   ¼±ÅÃÇ₃°ÅΩÅ° ¼±ÅÃÇ₃°ÅΩÅ° ¼±ÅÃÇ₃°ÅΩÅ° ¼±ÅÃÇ₃°ÅΩÅ° ¼±ÅÃÇ₃°ÅΩÅ° ¼±ÅÃÇ₃°ÅΩÅ° ¼±ÅÃÇ₃°ÅΩÅ°.

---

**Active Discovery of Devices**

1 ¼±ÅÃÇ₃°ÅΩÅ° ¼±ÅÃÇ₃°ÅΩÅ° ¼±ÅÃÇ₃°ÅΩÅ° ¼±ÅÃÇ₃°ÅΩÅ° ¼±ÅÃÇ₃°ÅΩÅ°.

   ¼±ÅÃÇ₃°ÅΩÅ° ¼±ÅÃÇ₃°ÅΩÅ° ¼±ÅÃÇ₃°ÅΩÅ° ¼±ÅÃÇ₃°ÅΩÅ° ¼±ÅÃÇ₃°ÅΩÅ° ¼±ÅÃÇ₃°ÅΩÅ° ¼±ÅÃÇ₃°ÅΩÅ°.

   ¼±ÅÃÇ₃°ÅΩÅ° ¼±ÅÃÇ₃°ÅΩÅ° ¼±ÅÃÇ₃°ÅΩÅ° ¼±ÅÃÇ₃°ÅΩÅ° ¼±ÅÃÇ₃°ÅΩÅ° ¼±ÅÃÇ₃°ÅΩÅ° ¼±ÅÃÇ₃°ÅΩÅ°.

---

**Loading a Hosts File**

1 ¼±ÅÃÇ₃°ÅΩÅ° ¼±ÅÃÇ₃°ÅΩÅ° ¼±ÅÃÇ₃°ÅΩÅ° ¼±ÅÃÇ₃°ÅΩÅ° ¼±ÅÃÇ₃°ÅΩÅ°.

   ¼±ÅÃÇ₃°ÅΩÅ° ¼±ÅÃÇ₃°ÅΩÅ° ¼±ÅÃÇ₃°ÅΩÅ° ¼±ÅÃÇ₃°ÅΩÅ° ¼±ÅÃÇ₃°ÅΩÅ° ¼±ÅÃÇ₃°ÅΩÅ° ¼±ÅÃÇ₃°ÅΩÅ°.

   ¼±ÅÃÇ₃°ÅΩÅ° ¼±ÅÃÇ₃°ÅΩÅ° ¼±ÅÃÇ₃°ÅΩÅ° ¼±ÅÃÇ₃°ÅΩÅ° ¼±ÅÃÇ₃°ÅΩÅ° ¼±ÅÃÇ₃°ÅΩÅ° ¼±ÅÃÇ₃°ÅΩÅ°.

---

**User's Guide**

---

WhatsUp Gold
Discover and Map Network devices
Import devices from a Hosts File.

• Discover Devices
Import devices from a Hosts File.

Note
ASCII IP Windows host.

2
WhatsUp Gold
Open
Edit tab

(Manually Drawing a Map)

Edit Mode
File Open
Edit tab

1
File New Map Wizard
Create a blank map
Blank map Edit mode Edit Toolbar

2
File New Map Wizard
Create a blank map
Blank map Edit mode Edit Toolbar

3
Draw Toolbar Editing a Network Map

4 File Save Save As
Active Discovery of Devices

(Reading a Network Map)

WhatsUp Gold Monitor Mode (polling)

User's Guide

WhatsUp Gold
Getting Information from the Network Map

Status, dependencies, Statistics,

Setting Map Polling Properties

Title, Title, Title. Title

User's Guide

WhatsUp Gold
Notification  

Poll Frequency. 10 3600. 1

Default Timeout. 30

(Saving and Naming a Network Map)

File Save  WhatsUp1.wup, WhatsUp2.wup, WhatsUp3.wup…WhatsUpn.wup

(Saving a Context)

Save Context  New  Context Name OK

1. File Save Context New  Context Name OK
2. Start as currently displayed.

Start in Mini Status mode. Start Minimized.

3. Reload Context on Startup.

4. OK.

1. File Open Context “Open Context.”

2. OK.
(Additional Mapping Techniques)

... some text ...

(Getting New Data into an Existing Map)

... some text ...

Active Discovery in WhatsUp Gold ...

... some text ...

Getting In and Out of Edit Mode ...

... some text ...

Exporting and Importing Map Data ...

... some text ...

(Active Discovery of Devices)

... some text ...

... some text ...

Scan method ...

... some text ...
**Note**

Using the Right Mouse Menu

**No scan.** active discovery

**Scan at intervals.** active discovery

**Scan at distributed intervals.** active discovery

**Rescan interval.** WhatsUp Gold

**Include new devices in poll.**

**Resolve Hostnames.**

**Advanced**

---

**SNMP community.**

**Notification.**

**Filter discovery results by device type.**
(Exporting and Importing Map Data)

Exporting a File

1. File ➔ Export ➔ (INI, XML, WUP)

2. 

Importing a File

1. File ➔ Import ➔ (INI, XML, WUP)

2. WhatsUp Gold ➔ 

Note

WhatsUp Gold is a C DLL library that can be used in C/C++ applications. It is available on the Ipswitch website (http://www.ipswitch.com/Support/whatsup/plugins.html), where you can also download the SDK. Ipswitch Business Development can provide additional support. C/C++ developers can also use the Ipswitch SDK for integration. Ipswitch offers OEM licensing options.

Save As

File ➔ Save As ➔ (wup, ini, xml)

WhatsUp Gold ➔ (.wup)

Simple INI (.ini)

Simple XML (.xml)
(Changing the Map Database Format)

WhatsUp Gold changes the map database format to .wup ASCII 8.0. 8.0.

WhatsUp Gold changes the map database format to ASCII.

Configure->Program Options Configure->Program Options

Map Database Map Database

Set as Default. Set as Default. Set as Default.

WhatsUp Gold changes the map database format to ASCII.

Set as Default.

Note

File->Open File->Save As

Configure. Configure. Configure.

User's Guide

WhatsUp Gold

Solve it HighTech

솔빛 하이테크
Traceroute (Traceroute Mapping)

Traceroute  is a tool for tracing the route of a packet as it travels from a source to a destination. IP addresses are used to determine the path that the packet takes. WhatsUp Gold provides a feature to perform traceroute and display the results.

Traceroute is used to “Tracing a Route (TraceRoute Tool)” and display the results.

Link Line (Mapping Link Lines)

Link Line is used to map connections between devices. SNMP SmartScan is used to discover devices on the network. “Link to” is used to connect a stub to a connected line. “Disconnect link” is used to disconnect a link. Edit is used to modify the link.

Note

- “Auto Discover” is used to automatically discover connected lines.

User’s Guide

WhatsUp Gold
**Link Line**

- "stub" lines.
- "connected like line".

**Colored link line**

- Lines connected to stubs.
- Stubs connected to stubs.
**Note**

- multi-select, "Attach to", "Disconnect", "Customizing Device Types"

---

**Using Custom Devices**

WhatsUp Gold supports workstation, router, printer (NT workstation, Ascend Pipeline)

---

**Creating a Subnet**

WhatsUp Gold supports subnet (segments)

- (parent network map) "Attach to", "Disconnect", "Customizing Device Types"

---

**Note**

SNMP, SmartScan "Mapping a Hierarchical Network"

---

WhatsUp Gold supports (disconnect)

1. "Attach to", "Disconnect", "Customizing Device Types"
2 Edit Mode tab

3 Subnet icon

4 Edit Mode tab

5 Subnet icon

6 Display Name, Subnet icon, Properties (Map Title, General)

7 Map Name, Subnet icon

8 Note

9 Monitor, Monitor This Item

10 OK

11 Map tab

Note

User’s Guide
2 Parent Map  대한 내용을 확인하고 연결된 장치를 검색합니다.

3 OK  확인합니다.

**Note:** View parent map  확인하고  Parent Map  확인합니다.

### Subnet setting.

Subnet map  확인하고  network parent map  확인합니다.

**Note:** View parent map  확인하고  View Parent Map  확인합니다.

Subnet setting.  확인하고 SmartScan  확인합니다.  Scan method:  Scan at intervals  확인하고  Scan method:  Scan at intervals  확인합니다.

Network  확인하고 Network  확인하고  Netmask  확인합니다.

Network  확인하고 Network  확인합니다.  Scan method:  Scan at intervals  확인하고  Scan method:  Scan at intervals  확인합니다.
Netmask. (segment) - Netmask - Netmask - IP.

(Master Switches and Misc. Settings)

- Enable status polling engine for all maps. Enables status polling engine for all maps.
- Enable active discovery engine for all maps. Enables active discovery engine for all maps. Active Discovery of Devices
- Enable event delivery engine for all maps. Enables event delivery engine for all maps.
Stack supports raw sockets 32-bit stack.

- Raw socket 32-bit.
- Windows NT 4.0.

Automatically load subnets when opening maps.

Resume previous device & service states when maps load.
(Editing a Network Map)

Edit Mode [tab]

• [Action 1]
• [Action 2]
• [Action 3]

(GETTING IN AND OUT OF EDIT MODE)

Edit Mode [tab]

Note: [Note 1]

(TIPS FOR MAKING A MAP EASIER TO READ)

• [Tip 1]
• [Tip 2]

User's Guide

WhatsUp Gold
### Edit Mode tab

- **Edit Mode tab**

  Editing a Network Map

  - **Arrange Icons**
  - **Type**

  Monitor

### Map tab

- **Map tab**

### Draw Toolbar

- **Draw Toolbar**

### Keeping Tools Active

- **Keeping Tools Active**

### Drawing

- **Drawing**
(Attached Lines)

1. Draw lines (free hand)
2. Attach to (/Attach)
3. Disconnect

(Setting the Map Display)

1. Click Properties
2. Edit Properties
3. Properties
4. Display
Use these settings as default for new maps.

Auto Resize.

Device Name.

Change Font.

Clip Names

Display Names

Wrap Names

Display unconnected link lines as stubs.
(Setting Map Colors and Views)

1. Configure Program Options > View Settings.

2. Colors > map views.

3. Current Item Color > map views.

(Optional Map Views)

Select map views > (dependencies, statistics, notifications, status) > View Settings. Select map views > (dependencies, statistics, notifications) > View Settings. Select map views > (map view) > select View Settings. Select map views > (map view) > select View Settings.

(Device States)

Select device states > (Device States) > Configure Program Options > Device States. Select device states > (Device States) > Configure Program Options > Device States. Select device states > (Device States) > Configure Program Options > Device States.

Responding. (poll) > (solid bright green).
Note “Responding” «ö»óÀ» What's Up Monitor Mode ·Î µ¹¾Æ°¡ WhatsUp Gold ·Î µ¹¾Æ°¡ ÀÇ ÀÀ»Ô´Ï´Ù À½ ÆúÁú ¶§ ±îÁöº¯°æµÈ»çÇ×À»º¼¼ö¾øÀ½¿¡À¯ÀÇÇϸéʽÿÀ.

Lost 1 pkt. µøÀÇÆú¿¡´ëÇØÀÀ´äÇÏÁö¾ÊÀºµð¹ÙÀ̽º¸¦³ªÅ¸³»´Â»öÀÔ´Ï´Ù.(solid light green)ÀÔ´Ï´Ù.

Lost 2 pkt. µøÀÇÆú¿¡´ëÇØÀÀ´äÇÏÁö¾ÊÀºµð¹ÙÀ̽º¸¦³ªÅ¸³»´Â»öÀÔ´Ï´Ù.(solid yellow)ÀÔ´Ï´Ù.

Lost 3 pkt. µøÀÇÆú¿¡´ëÇØÀÀ´äÇÏÁö¾ÊÀºµð¹ÙÀ̽º¸¦³ªÅ¸³»´Â»öÀÔ´Ï´Ù.(solid yellow)ÀÔ´Ï´Ù.

Lost 4-7 pkt. 4-7¼ÓÀûÀÎµøÀÇÆú¿¡´ëÇØÀÀ´äÇÏÁö¾ÊÀºµð¹ÙÀ̽º¸¦³ªÅ¸³»´Â»öÀÔ´Ï´Ù.(solid light red)ÀÔ´Ï´Ù.

Lost 8+ pkt. 8¿¬ÇÑµøÀÇÆú¿¡´ëÇØÀÀ´äÇÏÁö¾ÊÀºµð¹ÙÀ̽º¸¦³ªÅ¸³»´Â»öÀÔ´Ï´Ù.(solid dark red)ÀÔ´Ï´Ù.

Service down. µøÀÇÆú¿¡´ëÇØÀÀ´äÇÏÁö¾ÊÀºµð¹ÙÀ̽º¸¦³ªÅ¸³»´Â»öÀÔ´Ï´Ù.(solid purple)ÀÔ´Ï´Ù.

Inactive. µøÀÇÆú¿¡´ëÇØÀÀ´äÇÏÁö¾ÊÀºµð¹ÙÀ̽º¸¦³ªÅ¸³»´Â»öÀÔ´Ï´Ù.(solid dart grey)ÀÔ´Ï´Ù.

Creating Text Captions

1 Edit Mode tab Õ ¿É¼ÇÀ»ÀûÀýÈ÷¼³Á¤ÇÕ´Ï´Ù.

2 Text œè¼±Å¹öưÀ»¿øÇÏ´Â, Sample Text  œè¼±Åœè¼±Å¼ÇÀ»¿øÇÏ´Â.

3 Text Properties Ð¹Ú½º¿¡¼­ÅÖ½À´Ï´Ù. Text ÖÔ½À¿í, Sample Text Áöµµ¿¡µµÀÇÀ§Ä¡¿¡¸¶¿ì½ºÆ÷ÀÎÅ͸¦º¡¸®Å°°íÀÖ½À´Ï´Ù.

4 Transparent. Ð¹Ú½º¿¡¼­¿øÇÏ´Â, Sample Text Ð¹Ú½º¿¡¼­¿øÇÏ´Â.

User’s Guide

WhatsUp Gold
Font. Change Font
 Rotation. (degree) 0~360 °


5. OK

Dependency Arrow (Using Depnedency Arrows)

- “Up Dependent”
- “Down Dependent”
- “Invalid Up Dependent”
- “Invalid Down Dependent”

Invalid Dependency  “Viewing and Changing Dependencies”

Arranging the Toolbars

Edit Mode , WhatsUp Gold
(drag) 
(toolbar backdrop) 
(toolbar backdrop) 
(toolbar backdrop) 
(toolbar backdrop)

(Galleries)

Galleries 
Edit Mode 
Configure 
Program Options 
Properties 
Show Galleries box 

User's Guide

Solve it High tech!

Solvit 솔빛 하이테크

£¶£± ·¯¸®°¡ Áöµµ¿¡ ³ªÅ¸³³´Ï´Ù (ÆíÁý¸ðµå¿¡¼­ ½ÇÇà üũ¹Ú½º¸¦ ¼±ÅÃÇÏÁö ¾ÊÀ¸¸é °¶·¯¸®´Â »ç¿ë)
°¡´ÉÇÏÁö¸¸ Áöµµ°¡ ÆíÁý¸ðµå ÀÏ ¶§ ³ªÅ¸³ªÁö ¾Ê½À´Ï´Ù.

WhatsUp Gold
(Working with Devices)

WhatsUp Gold®  offers multiple ways to discover and map your network:
- "Discover and Map": Quickly find devices on your network, WhatsUp Gold®  offers a
  powerful tool to discover and map your network. IP and NetBIOS protocols are
  supported.
- General: General properties allow you to define basic information about your
  network devices.

(The Polling Method)

- TCP/IP, IPX for IPX, NetBIOS: Select the protocols to poll for device information.
- ICMP: Poll for ICMP (echo) and (track) packets.
- TCP/IP: Poll for TCP and UDP packets.
- NetBIOS: Windows and Novell NetWare protocols.
- IPX: Novell NetWare protocols.

Note: IPX and NetBIOS support is limited in certain operating systems, such as Microsoft
NWLink IPX/SPX Transport. For more information, refer to the "System Requirements".

User's Guide

WhatsUp Gold
1. Display Name ¾º¿¡¼­ º®½ºÆ® ¹Ú½º¿¡¼­. Display Name ¹ö¿¡¼­ pop-up ¼­ºê³Ý Properties ¶ À®½º General ¶ À®½º.

2. Display Name ¹Ú½º¿¡¼­, pop-up ¼­ºê³Ý Properties ¶ À®½º General ¶ À®½º.

3. Type ¹Ú½º¿¡¼­ ¾ÆÀÌÄÜÀÌ ³×Æ®¿öÅ© ÀÇ ÀÔ·ÂÇØ¾ß ¼­ºê³Ý. ³ªÅ¸ ÀÔ·ÂÇØ¾ß ¾º¿¡¼­ “Creating a Subnet” ¶ À®½º.

Note ¼­ºê³Ý (subnet) ¾º¿¡¼­ (parent map) ¶ À®½º ³ªÅ¸ ÀÔ·ÂÇØ¾ß ¼­ºê³Ý “Creating a Subnet” ¶ À®½º.


5. Poll Using ¾º¿¡¼­ IP Address ¶ Host Name ¶ À®½º.

Note Host Name ¾º¿¡¼­ IP Address ¶ Host Name ¶ À®½º.

6. Host Name. ¾º¿¡¼­ ICMP ¶ Services only ¶ IPX ¶ IP Address ¶ Host Name ¶ DNS ¶ ICMP ¶ IPX ¶ NetBIOS ¶ NetBIOS ¶ IPX ¶ IP Address ¶ Host Name.

7. IP Address ¾º¿¡¼­ IP Address ¶ À®½º.

User’s Guide ¾º¿¡¼­

WhatsUp Gold

1. Monitor. On/Off. up, down dependencies. Host up, down dependencies. Host Summary. OK.


3. Poll Frequency. 7 days a week, 24 hours a day. Poll Frequency. Check every n polls. (poll) 1, 2, 3. Check only if this device is up. Check only if this device is up. Check only if this device is up. Check only if this device is up. Check only if this device is up. Check only if this device is up. Check only if this device is up. Check only if this device is up. Check only if this device is up.
4 Poll Timeout

Poll Timeout: 1-30, 5, 10, 20, 30, 60, 90, 120, 180, 300, 600, 1200, 1800, 3600, 7200, 14400, 28800, 57600, 86400.

Note: Poll Timeout is Poll Frequency.

“Setting Map Polling Properties”.

5 Time Period

Change: 7 days a week, 24 hours a day.

Day of Week: 7 days a week.

Time of Day: 24 hours a day.

Between: Not between.

Note: Between: Not Between.

6 OK

OK: A → B "up dependency" (A up → B up). Check only if this device is up.

7 OK

OK: A → B "down dependency" (A down → B down). Check only if this device is down.

User’s Guide

WhatsUp Gold
(Using the Right Mouse Menu)

- **Cut**, **Copy**, **Paste**, **Delete**
- **New**
- **Attach to**
- **Bring to Front**, **Send to Back**
- **Lock Position**
- **Quick Status...**, **Properties...**

Cut, Copy, Paste, Delete (pop-up) (Edit Mode)

Monitor Mode

“Adding a Command to the Right Mouse Menu” (Edit Mode)

: 

Cut, Copy, Paste, Delete (pop-up)

Edit Mode

Monitor Mode

: 

\[ \text{Quick Status...} \]

Quick Status...

Quick Status (Using Quick Status)
Status:  

WhatsUp Gold status is active and responding.

Count:  

0 clients are connected.

RTT:  

Round Trip Time (RTT) is 0 milliseconds (milliseconds).

ICMP Status:  

Device Status:  

Service Status:  

Down Count:  

Total:  

WhatsUp Gold clients are connected.

Last Response Time:  

Configure:

>Program Options->View Settings
Note: "tool tip" in Windows is the same as "tip of the arrow" in MacOS.

1. History (Quick Status) - This displays the history of the event, up to 30 days, or until the user clears the log.

2. Up-Time (Quick Status) - This displays the uptime of the event.

3. Log (Quick Status) - This displays the log of the event, including "up" and "down" alerts. Alerts can be enabled in Properties (Quick Status) or Alerts Properties.

Adding a Command to the Right Mouse Menu:

1. Right-click in the right mouse menu. This opens the Properties and Menu Editor.

2. Add the command to the menu item. Edit Menu Item.

3. Menu Name - Enter the name of the menu item.

4. Command - Enter the command to be executed. For example:

   [telnet] - telnet.exe
   [ping] - Ping

User's Guide

WhatsUp Gold
[trace] - Traceroute
[browse] - IP URL

5

[trace] - Traceroute
[browse] - IP URL

Custom Menus (Adding Custom Menus to a Group of Devices)

Add Custom Menu to Selected Devices

Note

\(\text{tri-state}\)

• 

\(\text{ALL}\)

• 

\(\text{SOME}\)

• 

toggle

• 

\(\text{toggle}\)

• 

\(\text{toggle}\)

(Program Variables)

WhatsUp Gold

• 

\(\text{的实力}\)

• 

\(\text{的实力}\)

User’s Guide
Device Type

(Customizing Device Types)

(Creating a Device Type)

1 SmartScan  Scan MIB SNMP Object ID SNMP Read Community SNMP Write Community

2 Configure Device Types

User’s Guide

WhatsUp Gold
Device Types を開き、新しいデバイスタイプを作成します。以下の機能があります。

- **New.** ニューウィンドウを開きます。 New をクリックします。
- **Edit.** デバイスタイプのフィールドを変更します。 Edit をクリックします。
- **Copy.** デバイスタイプをコピーします。 Copy をクリックします。
- **Delete.** デバイスタイプを削除します。 Delete をクリックします。

3. New をクリックします。

4. General を開き、Device Type Name を入力します。
Icon Filename

... Icon Filename ...

 enviado WhatsUp Gold ...

 Note VDevice ...

 Overlay Text

... Overlay Text ...

 Polling Method

... Polling Method ...

 AutoRun Cmd

... AutoRun Cmd ...

 SNMP Object

... SNMP Object ...

 User's Guide

WhatsUp Gold
Scan SNMP object (asterisk) *.

```
1.3.6.1.4.311.1.1.3.1.3
1.3.6.1.4.1.311.1.1.3.1.3;1.3.6.1.4.1.311.1.1.3.1.4
1.3.6.1.4.1.311.1.1.3.1.3,4
1.3.6.1.4.1.311.1.1.3.1.1,3-4
1.3.6.1.4.1.311.1.1.3.1.*
```

**Note**.

```
- hosttype.ini: WhatsUp Gold
- hosttype.ini: Cisco 3204(1.3.6.1.4.1.9.1.37)
- hosttype.ini: Cisco 3xxx(1.3.6.1.4.1.9.1.32-37)
```

11 **Service** Add

12 **Event** Add

13 **Association** Add. 

14 **OK**.
(Changing the Double-Click Action for a Customized Devices)

- [default] -  
  [snmp] - SNMP 
  [telnet] - telnet.exe 
  [ping] - Ping 
  [trace] - TraceRoute 
  [browse] - IP Address, DblClk Action Parameter

(Running a script or program for customized devices)

1 Autorun Cmd
2 "Changing the double-click Action" parameter

(Add Web Menu Items to Devices)

1 File type:
2 "Add Web Menu Items to Devices" parameter

User's Guide

WhatsUp Gold
GUI Menu Items

[hosttype]
MCOUNT=count of menu items
MNAMEn=display name
MCMDn=command line
MARGn=arguments
(n is a number from 0 to MCOUNT-1)

Web Menu Items

[hosttype]
WCOUNT=count of menu items
WNAMEn=display name
WCMDn=URL
WARGn=arguments
(n is a number from 0 to WCOUNT-1)

Argument that are valid in MCMD or WCMD lines:

%a=address
%R=read community (also ‘c’)
%W=write community
%n=hostname
%1=object name (1=lower case L)
%1=info 1
%2=info 2
%T=hosttype
%O=host SNMP object id

1. WhatsUp Gold
2. WhatsUp Gold
3. Hosttype.ini

Note: “Ipswitch” is for [Old NT System] if needed. If the ‘ipswitch’ ends up being needed then remove the “Ipswitch” from the line above and put it directly in the line below.

Hosttype.ini

User’s Guide
[Old NT System]

BMPNAME=OldNTWorkstation.emf
SCOUNT=0
OBJID=1.3.6.1.4.1.311.1.1.3.1
EXECUTE=
AUTORUN=
TYPE=0
OVERLAYTEXT=OldNT
WCOUNT=0
MCOUNT=0

1. WCOUNT=0 (1) WNAME0=Ipswitch (n) (0) MCOUNT 1 (1) (1)

2. WNAME0=Ipswitch (n) (0) MCOUNT 1 (1) (1)

3. Type : WNAME0=Ipswitch (n) (0) MCOUNT 1 (1) (1)

4. WNAME0=Ipswitch (n) (0) MCOUNT 1 (1) (1)

5. Type : WCMD0=HTTP://WWW.IPSWITCH.COM (n) (0) MCOUNT 1 (1) (1)

6. File (n) (0) MCOUNT 1 (1) (1)

---

**Hosttype.ini.file, BEFORE your changes**

<table>
<thead>
<tr>
<th>[Old NT System]</th>
</tr>
</thead>
<tbody>
<tr>
<td>BMPNAME=OldNTWorkstation.emf</td>
</tr>
<tr>
<td>SCOUNT=0</td>
</tr>
<tr>
<td>OBJID=1.3.6.1.4.1.311.1.1.3.1</td>
</tr>
<tr>
<td>EXECUTE=</td>
</tr>
<tr>
<td>AUTORUN=</td>
</tr>
<tr>
<td>TYPE=0</td>
</tr>
<tr>
<td>OVERLAYTEXT=Old NT</td>
</tr>
<tr>
<td>WCOUNT=0</td>
</tr>
<tr>
<td>MCOUNT=0</td>
</tr>
</tbody>
</table>
### Hosttype.ini file, AFTER your changes

[Old NT System]
BMPNAME=OldNTWorkstation.emf
SCOUNT=0
OBJID=1.3.6.1.4.1.311.1.1.3.1
EXECUTE=
AUTORUN=
TYPE=0
OVERLAYTEXT=Old NT
WCOUNT=1
WNAME0=Ipswitch
WCMD0=HTTP:\WWW.IPSWITCH.COM
MCONTENT=0

---

1. **WhatsUp Gold**  
   - [ ]  

2. **Type list**  
   - “Old NT System”  
   - **OK**  

3. **Type list**  
   - “Old NT System”  
   - **OK**  

4. **Type list**  
   - “Ipswitch”  

5. **Type list**  
   - “Ipswitch”  

6. **Type list**  
   - “Ipswitch”  

**Note:**  
- After making changes, save the modified `hosttype.ini` file.  
- **Solve it**  

---

### (Using the Customized Devices on a Map)

1. **Device Types**  
   -  
   - **Custom Device Types**  
   - **(customized device type)**  
   - **(customized device)**  

2. **Device Types**  
   - **(device pool)**  
   - **Custom Device Types**  
   - **(customized device type)**  

3. **Device Types**  
   - **Map**  
   - **(monitor mode)**  

---

**User’s Guide**  

**WhatsUp Gold**
**Scanning and Mapping a Device**

Cisco 4000 (SmartScan) and Cisco 7200 (custom icon) (Scanning and Mapping a Device)

1. Discover your network using ICMP and SNMP object.
2. Discover your network using SNMP SmartScan and SNMP Communities.
3. Discover your network using SNMP Communities.

**Changing the Standard Device Icons**

- router

**Note**

WhatsUp Gold VDevice router.
(starting point) : bridge.emf, host.emf, subnet.emf, container.emf, hub.emf, lanbox.emf, printer.emf, router.emf, server.emf, workstn.emf

<table>
<thead>
<tr>
<th>Note</th>
<th>WhatsUp Gold</th>
<th>VDevice</th>
<th>.dse</th>
<th>.emf</th>
</tr>
</thead>
</table>

- VDevice [ ] .dse [ ] .emf [ ]
- VDevice [ ] .dse [ ] .emf [ ]

1. 

2. 

3. 

<table>
<thead>
<tr>
<th>Note</th>
<th>VDevice</th>
<th>.dse</th>
<th>.emf</th>
</tr>
</thead>
</table>

- VDevice [ ] .dse [ ] .emf [ ]
- VDevice [ ] .dse [ ] .emf [ ]
6 Monitoring Services

WhatsUp Gold provides various monitoring services, including:

- **TCP/IP** services (Telnet, DNS, SMTP)
- **TCP/IP** services (Radius, IRC, SSH, etc.)
- **SNMP**
- Microsoft's Component Object Model
- **Custom Services API**

Note: When monitoring, it is important to poll services regularly. A failed connection can be detected by checking the status log.

**Activity Log** allows you to view activity logs, including quick status.

**Status Log** provides a history of status changes.

**Notification** can be set to receive updates on failed connections.
**Note** TCP/IP monitoring includes: DNS, FTP, POP3, SMTP, NNTP, HTTP, SNMP, IMAP4, Echo, Gopher, Telnet, Time. 

**TCP/IP Monitoring Standard TCP/IP Services**

User's Guide

WhatsUp Gold
1. Scan

**Note**

2. Services

3. Auto Discover

**Auto Discover**

**General**

**Polling Method**

**TCP**

**Note**

**Service**

**IPX**

**NetBIOS**

**TCP/IP**

**User’s Guide**

WhatsUp Gold
1. **Monitor This Device**

2. **Services**

3. **Auto Discover**

4. **OK**

---

**Monitors and Services**

- **TCP/IP**
- **HTTP** (Content Scan)
- **Radius Server** (Remote Authentication Dial-In User Service)
- **IMail Server**
- **WS_FTP Server**
- **WhatsUp Gold Web Server v5**
- **WhatsUp Gold Web Server v6**
- **WhatsUp Gold Web Server v7**
• WhatsUp Gold Web Server v8

- TCP, IRC (Internet Relay Chat), Lotus Notes, Microsoft SQL, Microsoft Exchange, SMTP, POP3, Microsoft Exchange.

- TCP/IP services (SMTP, POP3) to monitor and alert on.

**TCP/IP Services (Defining a Custom TCP/IP Services)**

- WhatsUp Gold monitors TCP/IP services (handshake, rules expressions).
- Monitor TCP/IP services to identify “fail” connections, a rule expression to “fail” connections.
- Monitor TCP/IP services to identify “this”, “that”, “the other” connections.


![Monitor and Service Configuration](image.png)

- New Monitor

**User's Guide**

WhatsUp Gold
- **Edit** コピペをクリックしてください。（コピー・ペースト）
- **Copy** コピペをクリックしてください。（コピー・ペースト）
- **Delete** コピペをクリックしてください。（コピー・ペースト）

2 **New** をクリックしてください。

3 **Service Type** を **TCP/IP Service** に設定してください。

4 **Service Name** の設定にあたって、自分が指定したサービスの名前を入力してください。**Services** をクリックして、リストから選択することができます。

5 **OK** をクリックしてください。

6 **Network Type** を **TCP** に設定してください。
   - **TCP**，IRC(Internet Relay Chat) に設定してください。
   - **TCP**，RADIUS(Remote Authentication and Dial-In Service) に設定してください。

**User's Guide**

**WhatsUp Gold**
7  Port Number: TCP, UDP. 

- 6667, IRC (Internet Relay Chat)
- 1645, RADIUS (Remote Authentication and Dial-In Service)

8  Timeout: seconds.

Note: 

- 1-500 seconds
- 500 to 501 seconds
- 999 (milliseconds)

9  Command: String keyword, Send, Expect, SimpleExpect, Flow Control.

10 OK: Response.

11 SimpleExpect: String keyword, Expect keyword.

Script Syntax

Keywords:

- string, Send=keyword
- SimpleExpect=keyword
- Expect=keyword
- #symbol
- "error" "success" Flow Control Keywords

Examples:

- SimpleExpect=keyword
“SimpleExpect=Keywords”

• **Expect on connect**
  
  *Expect on connect*

• **Send command on connect**

• **Expected a command response**

  *Expected a command response*

• **Send to disconnect**

Note

### SimpleExpect Keywords

<table>
<thead>
<tr>
<th>Keyword</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>%nnn</td>
<td>Binary value (for example %000 is null, %027 is escape)</td>
</tr>
<tr>
<td>.</td>
<td>Matches any character</td>
</tr>
<tr>
<td>%</td>
<td>The “%” character</td>
</tr>
<tr>
<td>.</td>
<td>The “,” character</td>
</tr>
<tr>
<td>\</td>
<td>The “\” character</td>
</tr>
</tbody>
</table>

### Flow Control Keywords

*Flow Control Keywords*

*User’s Guide*
IfState – .Err ERR (ok error) true label true label.

: IfState ( ERR|OK) label

: IfState ERR End

IfState OK Bye

Goto – label label label.

: Goto End

: GotoEnd

Exit – ERR ERR (ok error) true true true true true label.

: Exit (ERR|OK)

: Exit ERR

Exit OK

: Label – label true label true label.

: Label “” label true label true label.

: :Bye

OnError – ERR|CONTINUE|GOTO label.

: OnError EXIT (Default behavior)

OnError CONTINUE

OnError GOTO Logoff

(Using Rules Expressions)

(Rules Expressions) search_text quantifier

User’s Guide

WhatsUp Gold
search_text

1 “Monitors&Services” Add/Edit Expect Rule, Rules Expression Editor.

2 contains Doesn’t contain

3 Match Case

4
• fail, fail
• quantifier(\, some, any, all )

5 OK
Rules Expressions Text and Quantifiers Tables

<table>
<thead>
<tr>
<th>Text Pattern</th>
<th>Expression</th>
</tr>
</thead>
<tbody>
<tr>
<td>Placing this in the first position (before any other expression) causes the search engine to start comparison with the first byte in the received buffer.</td>
<td>^</td>
</tr>
<tr>
<td>Match Any character</td>
<td>.</td>
</tr>
<tr>
<td>Match X or Y</td>
<td>(x/y)</td>
</tr>
<tr>
<td>Match Any word character (a-z, A-Z, 0-9)</td>
<td>\w</td>
</tr>
<tr>
<td>Match Any non-word character</td>
<td>\W</td>
</tr>
<tr>
<td>Match Any digit (0-9)</td>
<td>\d</td>
</tr>
<tr>
<td>Match Any non-digit</td>
<td>\D</td>
</tr>
<tr>
<td>Match Any white space (spaces and/or tabs and/or carriage returns)</td>
<td>\s</td>
</tr>
<tr>
<td>Match Any non-white space</td>
<td>\S</td>
</tr>
<tr>
<td>Match Any punctuation character (any printable character other than a space or alphanumeric characters)</td>
<td>\p</td>
</tr>
<tr>
<td>Match Any non-punctuation character</td>
<td>\P</td>
</tr>
<tr>
<td>Match '.'</td>
<td>.</td>
</tr>
<tr>
<td>Match Binary value</td>
<td>%nnn where nnn is a number between 0 and 255</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Quantifier</th>
<th>Expression</th>
</tr>
</thead>
<tbody>
<tr>
<td>Match Zero or more</td>
<td>*</td>
</tr>
<tr>
<td>Match One or more</td>
<td>+</td>
</tr>
<tr>
<td>Match n times</td>
<td>(n)</td>
</tr>
<tr>
<td>At least n1, but not more than n2 (where n1 and n2 are numbers)</td>
<td>(n, m)</td>
</tr>
</tbody>
</table>

Note: { } ( ) * + , . % \ 

Testing a Rules Expression

(Testing a Rules Expression)
1 Rules Expression Editor, Configure Monitors & Services. Rules Expression Editor, Configure Monitors & Services.

2 Rules Expression Editor, Contains Test Expression.

Comparison Result

The comparison text MATCHED the pattern specified.

Comparison Result

The comparison text DID NOT MATCH the pattern specified.

SNMP (Defining an SNMP Object to Monitor)

SNMP

2. New.
3. **Service Type**: SNMP Monitoring.

4. **Service Name**: Properties of Services.

5. **OK**.

![Monitor/Service Properties Interface](image)

6. **Object ID**: MIB SNMP Object Identifier.

7. **Check it for**: Constant Value, Range of Value, Rate of Change in Value. Help.

---

**Summary of Service Monitoring Requirement**

- Monitor This Device.
- Services to Monitor.

---

*Solve It HighTech!*
**API (Custom Services API)**

WhatsUp Gold® COM (Component Object Model) allows the user to "plug in" customized service checks. Specifically, WhatsUp Gold® COM allows users to "plug in" custom service checks, TCP/IP Service, COM, etc.

Ipswitch offers NT Service Monitor Plug-in, SNMP Threshold Plug-in, and more. Ipswitch provides a range of plug-ins.


WhatsUp Gold® COM allows users to "plug in" custom service checks. COM allows users to plug-in wugapi.h.

COM allows the user to "plug in" custom service checks, WUG allows users to "plug in" custom service checks. COM allows users to "plug in" custom service checks. COM allows users to "plug in" custom service checks.
7 Monitoring Events (Monitoring Events)

WhatsUp Gold• (Monitoring Events)

• Interval Polling – (HTTP, FTP etc.) (Monitoring Events) • (Monitoring Events) • (Monitoring Events) Status (Monitoring Events). • (Monitoring Events) (Monitoring Events).


Asynchronous event

• SNMP Traps – (Monitoring Events) (Monitoring Events) (Monitoring Events). SNMP (Monitoring Events) (Monitoring Events) (Monitoring Events). (Monitoring Events)

• Syslog Messages – (Monitoring Events) (Monitoring Events) (Monitoring Events) (Monitoring Events) (Monitoring Events) (Monitoring Events).

1. “Configuring the Event Servers”

2. Event Library

3. (Monitoring Events) (Monitoring Events) (Monitoring Events) (Monitoring Events)

4. (Monitoring Events) (Monitoring Events) (Monitoring Events) (Monitoring Events) (Monitoring Events) (Monitoring Events)

Note "The Event Notification Variable %(*)")“ The Event Notification Variable %(*)".
Windows Log Event, WhatsUp Gold
SNMP Syslog event, SNMP Log, WhatsUp Gold Syslog
Windows Log Activity Log, “Unsolicited”

Configure the Event Servers

Configure->Program Options->Event Servers Configure
SNMP, Syslog Entry, Windows Log

What is an Event Server?

Event Library, SNMP Trap Server, SNMP
“authenticationFailure”

User’s Guide

WhatsApp Gold
Event Library (Adding Events to the Events Library)

Configure->Events Library. Event Library -> Add Event. Configure the SNMP traps to enter New.

• Edit (the update to the trap definition.)

Note traps.txt SNMP traps Display Name OK.

Delete (the update to the trap definition.)

Note WhatUp Gold Event Server.

SNMP Trap Event (Defining an SNMP Trap Event)

Event Library SNMP traps New.
Display Name.

Enterprise/OID.  

Generic Type (Major).  

Specific Type (Minor).  

Add  Edit  Remove  Expression Editor

Note Expression Editor.  “Script Syntax”.

NOTE:  Edit  Remove (Auto Fill).

User’s Guide

WhatsUp Gold


Syslog Event (Defining a Syslog Event)

Event Library Syslog New.

Add Syslog Expression Editor. Syslog OK.

Display Name. Add Syslog Expression Editor. Syslog OK.

NOTE: Copy/Remove.


User’s Guide

WhatsUp Gold
Windows Log Event  DEFINE (Defining a Windows Log Event)

Event Library ➔  Windows Log ➔  ➔  New ➔  .

![Windows Log Event Editor](image)

**Display Name.**  ➔  ➔  ➔  .

**Source.**    ➔  ➔  ➔  .

**Type.**  ➔  ➔  ➔  .  NOTE: Windows  ➔  ➔  5  ➔  ➔  ➔  ➔  ➔  ➔  Error, Warning, Information, Success Audit, Failure Audit ➔  ➔  .

**Event ID.**  ➔  ➔  ➔  .

**Description.**  ➔  ➔  ➔  .

---

**Note**  ➔  ➔  description ➔  ➔  Add ➔  ➔  ➔  ➔  ➔  Expression Editor ➔  ➔  ➔  ➔  ➔  OK ➔  ➔  .

**Edit** ➔  Remove ➔  ➔  description ➔  ➔  ➔  ➔  (Auto Fill ➔  ).

**Browse.** ➔  ➔  ➔  Event Viewer ➔  ➔  ➔  ➔  .

---

User’s Guide

---

WhatsUp Gold
Event _copy_paste (Using Events for the First Time–A Simulation)

SNMP ེ་མི་དུ་ན་པར་གཏོང་། ངོམ་SNMP ཁ་བོ (IP 127.0.0.1 ལ་བུ་བུ་བུ་) མེད་པའི་SNMP རྐྱུང་། ངོམ་SNMP རྐྱུང་། མི་དུ་ན་པར་གཏོང་།.

• མི་དུ་ན་པར་གཏོང་། (IP 127.0.0.1 ལ་བུ་བུ་བུ་) ལེར་བུ་བུ་བུ་.
• མི་དུ་ན་པར་གཏོང་། ལེར་བུ་བུ་བུ་.
• མི་དུ་ན་པར་གཞི་བསྟེགས་པ་གཏོང་། ལེར་བུ་བུ་བུ་.
• མི་དུ་ན་པར་གཞི་བསྟེགས་པ་གཏོང་། ལེར་བུ་བུ་བུ་.

Adding an Event to a Device (Adding an Event to a Device)

“Creating a New Network Map” ལེར་བུ་བུ་བུ་.

1. Events ལེར་བུ་བུ་བུ་.
2. Add SNMP Trap – “Any” ལེར་བུ་བུ་བུ་.
3. OK ལེར་བུ་བུ་བུ་.
(Associating an Alert to your Event)

1. **Enable Alerts**
2. **Notification**
3. **On Event**
4. **Select Events**

**Note Event**
5. Click Help to view Help. Click Help to view Help.

6. Click OK to view OK.

**Event Visual Indicator**

Click OK to view OK. Click OK to view OK. Click OK to view OK.

**Manually Triggering your Event**

Click OK to view OK. Click OK to view OK. Click OK to view OK.

1. Enter SNMP and enter trap 127.0.0.1 to view trap.

2. Enter SNMP and enter trap 127.0.0.1 to view trap.

**Note**

Enter SNMP and enter trap 127.0.0.1 to view trap.
8 Notifications (Setting Up Notifications)

- activity, WhatsUp Gold
- WhatsUp Gold

- Activity Log, Activity Log
- Status Log
- Reading the Network Map

- notification

WhatsUp Gold

- pager
- SMTP

- Windows 98, Windows ME
- voice modem

- “Text to speech” notification
- SMS notification
- Windows NT
- WinPopup

- notification (recurring notification)
- “Sending Recurring Notifications”
Notifications (Defining Notifications)

Notifications Library notifications notifications notifications
Notifications Library notifications notifications

- Configure Notifications Library.

Note notifications WhatsUp Gold notification Notification

Notifications (Defining Beeper Notifications)

notification notification

1 Configure Notifications Library Beeper.

2 New notification notification Display Name “Beep Brad”.
3 **Beeper Number**: Enter the beeper number.

4 **Dial String**: Enter `ATDT%s,...,%s#`. What'sUp Gold only accepts `%s` and `#`. The dial string is the sequence of digits that the modem will send to make a call. The `ATDT` command initiates the dialing sequence, followed by the phone number and hanging up command.

5 **Modem Setup**: Choose `Primary` or `Alternate` modem setting. `Primary` is the default choice and `Alternate` is used as a backup. `Port Settings` is used to set up the modem port settings. A `notification` is a status message that can be sent to the modem when a certain event occurs. `Up Code` and `Down Code` are codes sent to the modem when the phone goes up or down. `SNMP Trap Code` is used for SNMP traps, which are notifications sent by the modem to the computer.

6 **Signal Codes**: `Up Code` and `Down Code` are sent to the modem to change the signal status. `SNMP Trap Code` is used for SNMP traps. `Item digital code` is a code used to send data to the modem.
7  **Port Settings**

- **Dial String.**  
  *notification*  

- **Baud Rate.**  
  *µî·ÏÁ¤º¸¿¡¼­* (bps, bit per second)

---

**Note**

- 56K  
  - 2400 bps - TAP specification
- 9600 bps

- **COM Port.**  
  *µî·ÏÁ¤º¸¿¡¼­*

- **Modem Initializing String.**  
  *ATE0Q0V1X4F1*  
  - “Command Echo Off(E0)”  
  - “Result Codes On(Q0)”  
  - “Verbal Results(V1)”  
  - “Extended Status(X4)”

- **Timeout.**  
  - *(success)*

---

8  **Æ÷Æ®¼³Á¤À»¹öewood OK**

9  **Æ÷Æ®¼³Á¤OK**  

**notification**  

* notification  

Test  

WhatsUp Gold  

Debug log

---

**Note**

- “(one way)”  
- (WhatsUp Gold)  
- feedback

- “(success)”

---

**notification**  

* notification  

Edit  

OK

Delete
Notifications (Defining Pager Notifications)

WhatsUp Gold® PageNet® TAP(Telocator Alphanumeric input Protocol) SMS-TAP NTT, UCP-SMS (British Telecom), NTT(Nippon Telegraph and Telephone)

1. Configure Notifications Library Pager.

2. New pager notification Display Name “Page Brad”.

3. Terminal Number Terminal Password.


5. Message String notification.


Note Port Settings.
7 Protocol

8 Port Settings

- **Modem Initialization String**
  - ATE0Q0V1X4F1
  - “Command Echo Off”(E0), “Result Codes On”(Q0), “Verbal Results”(V1)
  - “Extended Status”(X4)

- **Baud Rate**
  - 300, 1200, 2400
  - 8N1

---

**Note**

8N1. TAP specification. 7E1. 56K bit.

---

**COM Port**

---

9 OK

**Note**

---

10 Close

**Note**

---
SMS Notification (Defining SMS Notifications)

WhatsUp Gold SMS notifications allow you to receive SMS messages on your phone. This feature is useful for receiving important notifications or updates from your network.

1. **Configure**: Open the Notifications Library and add a new SMS notification.

2. **New**: Add a new notification and set Display Name.

3. **Country**: Choose the country code for your location.

4. **Provider**: Select your SMS provider.

**Note**: Note the country code for your location.

5. **Connection Settings**: Set the Mode to either Dialup or Email. Dialup is used for standard dial-up connections, while Email is used for a connection to an email server.

**Email to**: Set the SMS number to receive the email on. Example: GSMNumber@providerdomain.com

**Phone Number**: Set the phone number to use for the SMS notification. Example: 7705551234@voicestream.net
6. **Message.** ¹®È®·®×® ¨®â® notification ¹®È®×® ¨®â®×®.

7. **Characters Remaining.** ¹®È®·®×® ¨®â®×®×® ¹®È®×® ¨®â®×®×® ×® ¨®â®×®×®×® ¹®È®×®×®×® provider ¹®È®×®×®×®×®.

Notifications (Defining E-mail Notifications)

notification ¹®È®×®×®×® ×® ¨®â®×®×®×®×®×®×®×®×®×®×®×®×®×®×®×®×®×®×®×®×®×®×®×®×®×®×®×®×®

1. **Configure Notifications Library** ¹®È®×®×®×®×®×®×®×®×®×®×®×®×®×®×®×®×®×®×®×®×®×®×®×®×®×®×®×®×®×®×®×®×®×®×®×®×®×®×®×®×®×®×®×®×®×®×®×®×®×®×®×®×®×®×®×®×®×®×®×®×®×®×®×®

2. **New** ¹®È®×®×®×®×®×®×®×®×®×®×®×®×®×®×®×®×®×®×®×®×®×®×®×®×®×®×®×®×®×®×®×®×®×®×®×®×®×®×®×®×®×®×®×®×®×®×®×®×®×®×®×®×®×®×®×®×®×®×®×®×®×®×®×®×®×®×®×®×®×®×®×®×®×®×®×®×®×®×®×®×®×®×®×®×®×®×®×®×®×®×®×®×®×®×®×®×®×®×®×®×®×®×®×®×®×®×®×®×®×®×®×®×®×®×®×®×®×®×®×®×®×®×®×®×®×®×®×®×®×®×®×®×®×®×®×®×®×®×®×®×®×®×®×®×®×®×®×®×®×®×®×®×®×®×®×®×®×®×®×®×®×®×®×®×®×®×®×®×®×®×®×®×®×®×®×®×®×®×®×®×®×®×®×®×®×®×®×®×®×®×®×®×®×®×®×®×®×®×®×®×®×®×®×®×®×®×®×®×®×®×®×®×®×®×®×®×®×®×®×®×®×®×®×®×®×®×®×®×®×®×®×®×®×®×®×®×®×®×®×®×®×®×®×®×®×®×®×®×®×®×®×®×®×®×®×®×®×®×®×®×®×®×®×®×®×®×®×®×®×®×®×®×®×®×®×®×®×®×®×®×®×®×®×®×®×®×®×®×®×®×®×®×®×®×®×®×®×®×®×®×®×®×®×®

User’s Guide

WhatsUp Gold
3 Mail Server SMTP IP.

4 To, SMTP, SMTP (brackets, [ ]), (braces, { }), (quote, `), (parentheses, ( )).°¢

5 From notification. <WhatsUp@%1>, %1 ¿¡¼­, SMTP °ÅºÎ. °¢

Note “Notification Message Variables”. Debug log (Logs->Debug Log), WhatsUp Gold/¾ø½À´Ï´Ù.

6 Subject notification.

7 Message notification. (”Notification Message Variables”.)

8 OK notification.

notification Test WhatsUp Gold Debug log.

Notification notification Edit OK Delete.

Service Restart Notification (Defining Service Restart Notification)

Service Restart NT.
Configure Notifications Library Service Restart.

Note Help.

1. New Service Restart notification Display Name.

2. Host. MainDNS.


5. OK notification.

Note Notification.

Sound Notifications (Defining Sound Notifications)

Note Notification.

WhatsUp Gold NT notification "continuous" WUG.

User’s Guide
1 Configure Notifications Library Sound.

2 Add notification Display Name.

3 Filename Browse notification .wav. Sound Recorder filename Browse .wav. Sound Recorder .wav : PCM 8,000Hz, 16 bit, monaural .

4 Continuous play, Quiet . (¢:"Server1 Syslog")

5 OK.

Syslog Notifications (Defining Syslog Notifications)

1 Configure Notification Library Syslog .

2 Add , Syslog notification Display Name . (¢:"Server1 Syslog")

3 Syslog Port box Syslog UDP . 514 .

4 Syslog Server Address box Syslog IP .


User's Guide
Note

WhatsUp Gold IMail syslog syslog
SysLog? : Syslog "" "" "" "" ""

Syslog Port 514 Configure \nOptions \nConfigure \nProgram \nConfigure \nEvent Servers \nSyslog Entries \nConfigure \nConfigure \nConfigure \nConfigure \nConfigure

Text to Speech Notification (Defining Text to Speech Notification)

Text to Speech Plug-In text speech notification

1 Configure Notifications Library TextSpeech

2 Add TextSpeech notification Display Name

3 Speak Rate

4 Volume

5 Message notification

User's Guide

WhatsUp Gold
WinPopups Notification (Defining WinPopup Notifications)


WinPopup notification :

1 Configure Notifications Library WinPopup

2 New notification Display Name

3 Destination notification (asterisk,*)

4 Message notification (variables)
5 OK

**Notifications** (Defining Group Notifications)

- notification: Beeper/Tommy, Pager/Prod, Pager/Manager, WinPopup, WinPopupExternal, Notify All, Notify First, Notify Last, Notify All

1 Configure -> Notifications Library -> Group

2 New -> Group Name

3 Add -> “Add Group Member” -> Group Properties: Notify All Members, Notify First Member

- Time Period: 7X24 Change

**Note** Alert name: Up, Down, Delete

User’s Guide
4. 

Notifications 

- Notify First Member
- Up/Down
- Notify All Members

Example A. 

- notification: SeriousProblem
- notifications:

- PageTommy: 24 (Tommy)
- Page Brad: 24 (Brad)
- PageManager: 7 (Manager)

Example B. 

- notification: Operations

- BeepTara
- EmailTara
- BeepJan
- EmailJan

5. OK

Notifications (Defining Program Notifications)

- notification: “up”/“down”
1 Configure -> Notifications Library -> Program

2 New Program, Program notification Display Name

3 Program Filename, Program Working Path

4 Program Arguments

5 OK

6 OK

---

(Event Name Information)

coldstart specialmib-6.27
antherspecialmib.1.2.3.5-6.2031

org.9.83.121.115.109.111.110.76.111.103-6.2031

WhatsUp Gold

MIB

enterprises.3332.30.100.6-6.2
enterprises.3332.30.100.4-6.2
enterprises.3332.30.100.5-6.2
enterprises.3332.30.100.3-6.2
enterprises.3332.30.100.2-6.2
enterprises.3332.30.100.1-6.2

On Event

ipswitch-prd-bot-amp1-high-trap
ipswitch-prd-bot-audio-high-trap
ipswitch-prd-bot-door-trap-tripped
ipswitch-prd-bot-airflow-traps-6.2
ipswitch-prd-bot-humidity-high-trap
ipswitch-prd-bot-temperature-high-trap

On Event (More details for On Event – regarding SNMP Trap events)

User's Guide
Notification Variables (Notification Message Variables)

<table>
<thead>
<tr>
<th>Device Variable</th>
<th>Returns</th>
</tr>
</thead>
<tbody>
<tr>
<td>%1</td>
<td>Info line 1 (General)</td>
</tr>
<tr>
<td>%2</td>
<td>Info line 2 (General)</td>
</tr>
<tr>
<td>%a</td>
<td>IP Address (General)</td>
</tr>
<tr>
<td>%C</td>
<td>(notification Alert setup extra parameter)</td>
</tr>
<tr>
<td>%c</td>
<td>%T, %T : %c</td>
</tr>
<tr>
<td>%h</td>
<td>Host Name (General)</td>
</tr>
<tr>
<td>%M</td>
<td>SNMP Community</td>
</tr>
<tr>
<td>%m</td>
<td>(SNMP trap - Windows Event Log - Syslog)</td>
</tr>
<tr>
<td>%N</td>
<td>Notes (Note)</td>
</tr>
<tr>
<td>%n</td>
<td>Display Name (General)</td>
</tr>
<tr>
<td>%O</td>
<td>SNMP Object (SNMP Object)</td>
</tr>
<tr>
<td>%R</td>
<td>SNMP Read Community (SNMP)</td>
</tr>
<tr>
<td>%S</td>
<td>WhatsUp Gold (&quot;timed out&quot; &quot;did not respond&quot;)</td>
</tr>
<tr>
<td>%s</td>
<td>Winsock</td>
</tr>
<tr>
<td>%T</td>
<td>device Type (General)</td>
</tr>
<tr>
<td>%u</td>
<td>&quot;UP&quot;, &quot;DOWN&quot;, &quot;TRAP&quot;, &quot;Event name&quot;, &quot;SVCUP&quot;, &quot;SVCDOWN&quot;</td>
</tr>
<tr>
<td>%V</td>
<td>&quot;services&quot;</td>
</tr>
<tr>
<td>%w</td>
<td></td>
</tr>
<tr>
<td>%Y</td>
<td>SNMP Write Community (SNMP)</td>
</tr>
<tr>
<td>%z</td>
<td>UP</td>
</tr>
<tr>
<td>%y</td>
<td>UP</td>
</tr>
<tr>
<td>%z</td>
<td>UP</td>
</tr>
<tr>
<td>%(*</td>
<td>payload &quot;The Event Notification Variable %(*)&quot;</td>
</tr>
</tbody>
</table>

User's Guide

WhatsUp Gold
### System Variable Case Sensitive

<table>
<thead>
<tr>
<th>Variable</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>%A</td>
<td>Names of devices with down Service</td>
</tr>
<tr>
<td>%D</td>
<td># of Down Hosts</td>
</tr>
<tr>
<td>%d</td>
<td>Date format is (mm/dd/yyyy)</td>
</tr>
<tr>
<td>%e</td>
<td>Down Host display Names</td>
</tr>
<tr>
<td>%L</td>
<td>The Activity Log file, EV-yyyy-mm-dd.tab (or %Lnn where nn = last nn lines of the log file)</td>
</tr>
<tr>
<td>%Ln</td>
<td>Last n lines of the log file (n can go up to 99)</td>
</tr>
<tr>
<td>%I</td>
<td>Display Name from General of device properties</td>
</tr>
<tr>
<td>%o</td>
<td># of devices with Down Services</td>
</tr>
<tr>
<td>%P</td>
<td>Up Host display Names</td>
</tr>
<tr>
<td>%t</td>
<td>Current time (hh:mm:ss)</td>
</tr>
<tr>
<td>%U</td>
<td># of Up Hosts</td>
</tr>
</tbody>
</table>

#### Notification (The Event Notification Variable %(*))

8.0 没有找到“Monitor Events” jurisdiction. 使用 event notification 通知给用户. 使用 %(*)

#### Note

8.0 没有找到SNMP payload. 使用 %u, %m 事件通知.

- %u 事件通知 TRAP %m 事件.
- %(* 事件通知 payload %code 事件通知)

1. %(* 事件通知 Alert 事件通知)
2. %(* 事件通知 SMTP Mail 事件通知)
3. %(* 事件通知 WinPopup 事件通知)
4. “%(*) notification %m notification”.

Note: “Event Variable %(*)”.

Notifications (Testing the Notifications)

notification, Notification Editor, notification Test. WhatUp Gold.

Debug Log(Logs->Debug Log).

Setting Up a Voice Modem


User's Guide

WhatsUp Gold

1 Microsoft Unimodem/V (unimodv.exe) [readme.txt]

2 Unimodem/V [readme.txt]

3 WhatSp Gold .wav [readme.txt]

4 Voice .wav [readme.txt]

5 COM System -> Device Manager -> Ports [readme.txt]

Note [readme.txt]
Notifications (Defining Voice Notifications)

(“Setting Up a Voice Modem” “” , notification “” , “”

WhatsUp Gold “” , “” , “”.

notification “” , WhatsUp Gold “” , “”.

(“pressone.wav”) “WhatsUp has a message for you. Press one for the message.” “” , “A host is down.” “”.

“Gyro is down”), “Add Notifications” “”.

“Assigning Alert to Devices” “”.

notification (Creating a voice notification)

Note “” , Unimodem/V “” , Voice “”.

notification “”:

1 Configure -> Notifications Library “” , Voice “”.

2 Add “” , notification “” , Display Name “”.

3 Phone number “”.

4 Repeat Msg “” , WhatsUp Gold “” , “” (.wav) “”.

Invoke Sound Recorder “”.

5 Count “”.

User’s Guide

WhatsUp Gold
6 Button  

Note: notification (Repeat Msg) is now available.

(Repeat Msg) is now available to allow you to play back a .wav file.

The following .wav files are available in the Alerts:

<table>
<thead>
<tr>
<th>Property</th>
<th>Default .wav file</th>
<th>Message</th>
</tr>
</thead>
<tbody>
<tr>
<td>Item Down</td>
<td>isdown.wav</td>
<td>&quot;is down&quot;</td>
</tr>
<tr>
<td>Item Up</td>
<td>isup.wav</td>
<td>&quot;is now reachable.&quot;</td>
</tr>
<tr>
<td>Svc Down</td>
<td>svcdown.wav</td>
<td>&quot;a service is down on.&quot;</td>
</tr>
<tr>
<td>Svc Up</td>
<td>Svcup.wav</td>
<td>&quot;the service is now up on...&quot;</td>
</tr>
<tr>
<td>Wave file(in Alerts)</td>
<td>Ahost.wav</td>
<td>&quot;a host...&quot;</td>
</tr>
</tbody>
</table>

7 OK  

Alerts  (Assigning Alerts to Device)

Note: alert notification is now available to assign .wav files to alerts.

"Defining Notifications" is now available.

User's Guide

WhatsUp Gold
You can assign alerts to selected devices. This can be done in the "Assigning Alerts to Selected Devices" section.

### Alerts Dialog

*Using the Alerts Dialog*

**Alerts** can be configured as follows:

- **(logging)**
- **(sound alarm)**
- **Notifications**

**Alerts** can be set to:

1. **(logging)**
2. **Notifications**

**Note**
3 Enable Alerts.

4 WhatsUp Gold (Event Log) “DOWN”/“UP” Enable Logging Log Quick Status.

Alerts (Assigning Alerts to Selected Devices)

1. Create alerts.
2 Enable Alerts. alerts alerts alerts alerts.

3 Enable Logging. WhatsUp Gold up up up up.

Note Alerts alerts alerts alerts alerts.

- alert alert alert alert alert.
- alert alert alert alert alert.
- toggle toggle toggle toggle.
- alert alert alert alert alert.
- alert alert alert alert alert.

4 Alert Add Alert Add Alert.

5 Alert Edit Edit Edit.

Notification Alert Alert Alert (Assigning a Notification to an Alert)
2 notification notification notifications browse notification. (notification library)

Note NT WhatsUp Gold notification "continuous" WUG notification WUG "continuous".

3 Trigger notification notification notification notification. WhatsUp Gold notification 4 notification.

4 Device Identifier. notification notification notification notification. notification notification wave notification notification notification.

- notification notification notification notification. (IP, IP) "UP" "Down" notification notification. Note: (*) IP notification notification.

- notification notification notification notification. notification notification display_name.wav("Server one is down.") display_name.wav("Server one"). display_name.wav("Server one") display_name.wav([auto]) notification.
server1.wav) “a host” (a host.wav) “A host is down.” (ahost.wav)

5 Time Period ¼½¼Ç¿¡¼­ ÇØ´ç µð¹ÙÀ̽º·ÎºÎÅÍ ¾ðÁ¦ notification À» ¹ÞÀ» °ÍÀÎÁö¸¦ ÁöÁ¤ÇÕ´Ï´Ù. Change 7days (7days a week, 24hours a day) À» 7days a day.

6 Actions:
(¼±ÅûçÇ×) Auto send UP alert after sending DOWN alert ¼±ÅÃÇØ, ÇØ´ç µð¹ÙÀ̽º ¿Í ÀÌ µð¹ÙÀ̽ºÀÇ ·Î ¡µÇ¾úÀ» ¶§ up. NOTE: ¼±ÅÃÇØ “Up Alert Modes” À» ÁöÁ¤Ç Wolff.

• Send UP alert after the device and all services are up. ¼±ÅÃÇØ ¼±ÅÃÇØ ¼±ÅÃÇØ ¼±ÅÃÇØ ¼±ÅÃÇØ ¼±ÅÃÇØ up. up. up. up. up. up. up.

• Send individual UP alerts for the device and each service the comes up. ¼±ÅÃÇØ ¼±ÅÃÇØ ¼±ÅÃÇØ ¼±ÅÃÇØ up. up. up. up. up. up. up. up. up. up. up. up. up. up. up.

Send alert even if console response ¼±ÅÃÇØ. WhatsUp Gold ¼±ÅÃÇØ ¼±ÅÃÇØ ¼±ÅÃÇØ ¼±ÅÃÇØ ¼±ÅÃÇØ ¼±ÅÃÇØ alerts. (Monitor→ Acknowledge)

Alerts (Editing Alerts)

- Alert
- Alert (i.e. notification)

Note

Assigning a Notification to an Alert
(Working from the console)

WhatsUp Gold µð¹ÙÀ̽º (device pool)µùø³Çϱâ. ; :; (console)µùø³Çϱâ (web interface)µùø³Çϱâ. WhatsUp Gold µð¹ÙÀ̽º

WhatsUp Gold µð¹ÙÀ̽º ÀÎÅÍÆäÀ̽º¸¦.  °¡Áö°í ÀÖ½À´Ï´Ù. ÀÛ¾÷Çϱâµùø³Çϱâ ÀÎÅÍÆäÀ̽º¸¦. ÀÎÅÍÆäÀ̽º¸¦

11° Working from a Web Browser”µùø³Çϱâ ÀÎÅÍÆäÀ̽º¸¦.

(Opening Network Maps)

WhatsUp Gold µð¹ÙÀ̽º µî·ÏÁ¤º¸ÀÇ ¾ÆÀÌÄÜÀº ÑÊ. WhatsUp Gold µð¹ÙÀ̽º ÀÎÅÍÆäÀ̽º, File -> Open. 

File -> New Map Wizard µùø³Çϱâ. “1 2” : Creating Network Maps”µùø³Çϱâ ÀÎÅÍÆäÀ̽º¸¦.

3×Æ®¿öÅ© µð¹ÙÀ̽º µî·ÏÁ¤º¸ÀÇ ¾ÆÀÌÄÜÀº ÑÊ. ¾ðÁ¦µç ÀÚµ¿ Áöµµ ÄÜÀº ÀÔ´Ï´Ù.

Configure-> Program Options-> General µùø³Çϱâ. Automatically load subnet when opening maps”µùø³Çϱâ ÀÎÅÍÆäÀ̽º¸¦.

Monitor This Item µùø³Çϱâ. (°¢°¢ ºê³Ý À» ) µùø³Çϱâ. Monitor µùø³Çϱâ.

(Starting and Stopping Polling)


Configure->Program Options-> General µùø³Çϱâ. Polling Master Switch µùø³Çϱâ. ÀÎÅÍÆäÀ̽º¸¦ µùø³Çϱâ. ÀÎÅÍÆäÀ̽º¸¦ µùø³Çϱâ.
To Initiate Automatic Polling

(To Initiate Automatic Polling)

To initiate automatic polling, WhatsUp Gold must be running. Open the Master Switch, and select the monitoring device.

In the WhatsUp Gold interface, navigate to the Properties -> General -> Poll Frequency -> Default Timeout. General -> Dependencies tab -> Viewing and Changing Dependencies.

To stop automatic polling, stop the Watchdog thread on the device. Stop the Watchdog using the Watchdog button.

Note: When initiating automatic polling, WhatsUp Gold will automatically check 30 minutes from the last poll. If the poll is unsuccessful, WhatsUp Gold will attempt to check the device again. Ctrl+Alt+Del (task) will start a new pop-up Check now window.
(Reading the Network Map)

- **(highlight)** : "Types of Events Logged".
- **(highlight)**: "UP".
- **(highlight)**: "DOWN".

**Note**: 8

**Help**

“Program Options(Map Color)”

**WhatsUp Gold**

Enabled Alerts

**User’s Guide**

Quiet button

WhatsUp Gold
Stop Alarm.

Notifications (Receiving Notifications)

- notifications:
  - notifications:
  - notifications:
  - notifications:

Notifications, View Notifications. “Viewing Active Notifications”.

(Acknowledge Alerts)

Monitor Acknowledge. Acknowledge Send alert even if console response alert (Device properties-
>Alert-Add Edit). “Optional Map Views”.

Status Window (Using the Status Window)

Status Window. Note “Optional Map Views”.

View, Status.
Status Window ¼­ºñ½º ªóÅÂ Á¤º¸¸¦ ·Á¸é.

Poll button

Dependencies ¼³Á¤ ÇÏ´Â (Viewing and Changing Dependencies)

Dependencies ¼±ÅÃÇÕ´Ï´Ù.

Traceroute dependencies (Set Dependencies) ³ì»ö "up dependency" ³ªÅ¸³À´Ï´Ù.

View Æú¸µ, Dependencies ³ªÅ¸³».
Note (¿É¼Ç»çÇ×) Ð tabla Ð ¿É¼Ç»çÇ×. Ð È±£³£¸ “Optional Map Views” Ð È±£³£¸ Ð¿É¼Ç»çÇ×.

Dependencies Ð È±£³£¸ “Optional Map Views” Ð È±£³£¸ “up or down dependencies”. Ð È±£³£¸ “Optional Map Views” Ð È±£³£¸ “identifier”.

Poll Sequence and Up Dependencies. ÐÈ±£³£¸ “up dependent”. Ð È±£³£¸ “up dependent” Ð È±£³£¸ “identifier”. ÐÈ±£³£¸ “identifier”.

• Polling Sequence and Up Dependencies ÐÈ±£³£¸ “identifier”, popup ÐÈ±£³£¸ “identifier”.

• ÐÈ±£³£¸ “identifier” ÐÈ±£³£¸ “identifier”, popup ÐÈ±£³£¸ “identifier”.

• ÐÈ±£³£¸ “identifier” ÐÈ±£³£¸ “identifier”, popup ÐÈ±£³£¸ “identifier”.

Start of Poll. ÐÈ±£³£¸ “identifier” ÐÈ±£³£¸ “identifier”.

Move Earlier in Poll. ÐÈ±£³£¸ “identifier” ÐÈ±£³£¸ “identifier”.

End of Poll. ÐÈ±£³£¸ “identifier” ÐÈ±£³£¸ “identifier”.

Later in Poll. ÐÈ±£³£¸ “identifier” ÐÈ±£³£¸ “identifier”.

User’s Guide

WhatsUp Gold
Up Dependencies Down Dependencies (Setting Up and Down Dependencies)

“up” or “down” dependency. “up” dependency and “down” dependency.

Dependencies Up Dependencies, Down Dependencies. “dependent” dependency.

“up” or “down” dependency.

1 Up Dependencies Down Dependencies dependency dependency dependency.

2 dependency dependency.

3 Depend on Prior Device dependency.

Note Invalid Dependencies.

(Viewing the Polling Statistics)


Note (tab) “Optional Map Views”.

VIEW [map_name].wui.
Device. [Device.
Address. [Address.
Type. [Type.
Status. [Status.

- Monitor • Reset Counters [Reset Counters
- Advanced

Period. [Period
Count. [Count
% Responded. [% Responded
% Missed. [% Missed

Down Time. [Down Time

#Alerts. [Alerts
Avg RTT. (round trip time, RTT)
Min RTT. RTT
Max RTT. RTT

Notifications (Viewing Active Notifications)

Notifications. View notifications.
Notification.

(Using the Mini Status View)

Mini Status. Mini Status.
Mini Status Mode.
Mini Status.
(Logging and Reporting)

WhatsUp Gold

• Syslog – UNIX (down), UNIX (up), UDP (SL-yyy-mm-dd.tab)

• Activity - Activity Log (EV-yyy-mm-dd.tab)

• SNMP traps - SNMP Trap Log (ST-yyy-mm-dd.tab)

Performance Graphs.

Outage Reports.

Statistics Reports.

User's Guide

WhatsUp Gold
WhatsUp Gold Syslog

WhatsUp Gold Syslog

What's Up Gold  Syslog Daemon  
SYSLOG (switch), UNIX  UDP  UDP  514  UDP  UDP  UDP  udp://example.com:514/65.18.20.20

Syslog []  514  UDP  UDP  UDP  udp://example.com:514/65.18.20.20

Activity Log  (Logging and Reporting Activities)

What's Up Gold  Activity Log  Activity  
EV-yyyy-mm-dd.tab

Alerts  activity( )

Enable Logging  activity( )

What's Up Gold  activity( )

import  tab-delimited( )

Activity Log  (Actions that Trigger Entries in the Activity Log File)

Map Changes  

Monitoring Events  

Alert  Enable Logging  

 WhatsUp Gold  up/down  

User's Guide
Notifications:

Acknowledged Alerts: Monitor ➔ Acknowledge


NT Service: NT up/down

Activity (Changing How Activities Are Logged)

1. Properties

2. Alerts

3. “DOWN” ➔ “UP” ➔ Enable Logging ➔ Quick Status ➔ Log ➔ Trigger

Logging Trigger ➔ 1 ➔ 2 ➔ 3 ➔ 4 ➔ Trigger ➔ Edit

Trigger ➔ alert ➔ Trigger ➔ Trigger ➔ Trigger ➔ Trigger ➔ Trigger ➔ Trigger ➔ Trigger ➔ Trigger ➔ Trigger ➔ Trigger

User's Guide

WhatsUp Gold
Note: notification  alarm notification.

Activity Log  “DOWN” “UP” (event) notification.

Trigger  Logging Trigger.

4  OK  

1  Add Alerts to Selected Devices.

2  Enable Logging.

3  Logging Trigger.

Activity  (Viewing the Activity Log)

Activity Log  “Actions that Trigger Entries in the Activity Log File”.

Activity , Logs  Activity Log.

Activity Log is the WhatsUp Gold activity log. It is used to record events and activities related to the network. It is divided into two sections: the main activity log and the alert acknowledgments.

Log Viewer: The Log Viewer is used to view the activity log. It allows users to filter and search for specific activities.

<table>
<thead>
<tr>
<th>Icon</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Back</td>
<td>‘Back’ button for going back to previous activity.</td>
</tr>
<tr>
<td>Current</td>
<td>‘Current’ button to view current activity.</td>
</tr>
<tr>
<td>Forward</td>
<td>‘Forward’ button for going forward to next activity.</td>
</tr>
<tr>
<td>Find</td>
<td>‘Find’ button to search for specific activities.</td>
</tr>
<tr>
<td>Filter</td>
<td>‘Filter’ button to filter activities.</td>
</tr>
</tbody>
</table>

Note: The “Back”, “Forward” buttons allow users to navigate through the activity log. The “Find” button can be used to search for specific activities. The “Filter” button allows users to filter activities based on specific criteria.
Week(s), Month(s), Year(s) and Range:

- Week(s):
  - 1 'Back' 7
- Month(s):
  - 1 'Back' 4
- Year(s):
  - 1 'Back' 52
- Range:

Refresh icon: (SYSLOG ·Î±× º¸±â»óÅ¿¡¼­¸¸ ÇÊ¿äÇÔ) 'Refresh'

Print icon: ·Î±×º¸±ââÀÌ ¿­·ÁÀÖÀ¸¸é, 'Print'

Format option buttons: ‘Raw’ ‘Formatted’

Outage Report (Creating an Outage Report)

WhatsUp Gold ·Î±×º¸±âº¹Çϱ⿡ ÇæºÐÇÒ¸¸Å­Áöµµ¸¦¸ð´ÏÅ͸µÇÑÈÄ¿¡, ‘Actions that Trigger Entries in the Activity Log File’

Outage Report ·Î±×º¸·Á¸é, 1 Reports, Outage Report ·Î±×º¹ÝÇÑ. Create Outage Report ·Î±×º³ªÅ¸³³´Ï´Ù.
2  Click on the Map Name field.

**Note**
- (child map) and (parent map) display the child and parent maps.
- child map

3  Report Type

**Summary.**
- Worst First

**Detail.**
- “up” and “down” activity
- Worst First

- Detail Report
- Activity (import), table lockout
- Activity (export)

**Raw Data.**
- Event Log
- Date Range

4  Click OK, Start Date, and End Date.

5  OK
WhatsUp Gold: Report Feature

Note: “insufficient data” indicated in the report. Additional information is required to complete the report.

Debug Log Information

Outage Reports (Using the Command Line for Outage Reports)

Basic Command Syntax

### Argument Explanation

<table>
<thead>
<tr>
<th>Argument</th>
<th>Explanation</th>
</tr>
</thead>
<tbody>
<tr>
<td><code>-m mapname</code></td>
<td>The map name. Example: <code>wugrpt -m &quot;c:\program files\WhatsUp\network1.wup&quot;</code></td>
</tr>
<tr>
<td><code>-s yyyyymmdd</code></td>
<td>The start date. Example: <code>wugrpt -s 20020301</code></td>
</tr>
<tr>
<td><code>-e yyyyymmdd</code></td>
<td>The end date. Example: <code>wugrpt -e 20020331</code></td>
</tr>
<tr>
<td><code>-l logfile</code></td>
<td>The log file. Example: <code>wugrpt -l wugrpt.log</code></td>
</tr>
<tr>
<td><code>-o sortmode</code></td>
<td>The sort mode. Example: <code>wugrpt -o &quot;score&quot;</code></td>
</tr>
<tr>
<td><code>-r report</code></td>
<td>The report format. Example: <code>wugrpt -r event reports</code></td>
</tr>
<tr>
<td><code>-t maptitle</code></td>
<td>The map title. Example: <code>wugrpt -t &quot;Boston1&quot;</code></td>
</tr>
<tr>
<td><code>-?</code></td>
<td>Displays help. Example: <code>wugrpt -?</code></td>
</tr>
</tbody>
</table>

### Examples

1. **Boston1 Event Reports**

   `wugrpt -m "c:\Program Files\WhatsUp\Boston1.wup"`

2. **Specific Dates**

   `wugrpt -m "c:\Program Files\WhatsUp\Boston1.wup" -s 20020301 -e 20020331`

### Return Codes

- 0: Normal operation
- 1: Errors or warnings
Logging and Reporting Polling Statistics

WhatsUp Gold [Logging and Reporting Polling Statistics]

WhatsUp Gold [The Polling Statistics]

Average RTT. Round Trip Time(RTT). “Changing Statistics Logging”

Maximum RTT. (°¢°¢ÀÇ µð¹ÙÀ̽º¿¡ ±â·ÏµË´Ï´Ù)

Minimum RTT. (°¢°¢ÀÇ µð¹ÙÀ̽º¿¡ ±â·ÏµË´Ï´Ù)

Percentage of missed polls. “Creating Performance Graphs”

Statistics Log(ST-yyyy-mm-dd.tab) ¿¡±â·ÏÇ ϸé

Statistics Log(ST-yyyy-mm-dd.tab) (import) ¿ ¡±â·ÏÇ ϸé tab-delimited(°¢°¢ÀÇ µð¹ÙÀ̽º¿¡ ±â·ÏµË´Ï´Ù) ¿¡±â·ÏÇ ϸé

Statistics Log(ST-yyyy-mm-dd.tab) ±â·ÏµµÇ´Â §é µé¿¡

Statistics Log(ST-yyyy-mm-dd.tab) ±â·ÏµµÇ´Â §é µé¿¡

Statistics Log(ST-yyyy-mm-dd.tab) ±â·ÏµµÇ´Â §é µé¿¡
(Changing Statistics Logging)

Statistics log (ST-yyyy-mm-dd.tab) [:]

Statistics log [:]

1 Configure Program Options, Logging .

2 Log type “WhatsUp Statistics”.

3 Advanced .

4 Log update interval . 0 254 . 0 .

5 ( ) Update Log .

(Creating Reports on Polling Statistics)

WhatsUp Gold .

1 Reports Statistics Report .

2 Map Name .

Note (child map) (parent map) . (child map) .

User's Guide

WhatsUp Gold
3 Report Type

Detail. Statistics Log (import) tab-delimited format “Statistics Report Legend”.

Report Window

Date Range, Start Date, End Date.

4 OK

5 Note

“insufficient data”.

User’s Guide

WhatsUp Gold
Exporting Raw Data

Statistics Report raw data. tab-delimited (import) raw data (spreadsheet) raw data (import).

### Statistics Report Legend

- Statistics Log ST-yyyy-mm-dd.tab
- WhatsUp Gold Statistics Log (samples)

- Sample: 
- Average RTT: 
- Average Maximum RTT: 
- Average Standard Deviation: 
- Average Minimum RTT: 
- Average Percentage of Missed Polls: 

User's Guide

WhatsUp Gold
(Using the Command Line for Statistics Reports)

`wugstat.exe` WhatsUp Gold Statistics Log(`ST-yyyy-mm-dd.tab`)  ·¸ìðµà¹¿ł ñëêµò (`wugstat.exe`)  ·¸ìðµà¹¿ł 

(command prompt), ¼ì MS-DOS prompt ¼ì `wugstat.exe`  ñëêµò (`wugstat.exe`)  ñëêµò  `wugstat.exe`  ñëêµò (`command prompt), ¼ì MS-DOS ½ø ñëêµò  `wugstat.exe`  ñëêµò.

Basic Command Syntax

```
```

<table>
<thead>
<tr>
<th>Argument</th>
<th>Explanation</th>
</tr>
</thead>
<tbody>
<tr>
<td><code>-mmapname</code></td>
<td>(Local) <code>.*</code> <code>local.*</code></td>
</tr>
<tr>
<td><code>-syyyymmdd</code></td>
<td>(Local) <code>-s</code> <code>yyyy-mm-dd</code></td>
</tr>
<tr>
<td><code>-ddyyyymmdd</code></td>
<td>(Local) <code>-d yyyy-mm-dd</code></td>
</tr>
<tr>
<td><code>-eyyyymmdd</code></td>
<td>(Local) <code>-e yyyy-mm-dd</code></td>
</tr>
<tr>
<td><code>-llogfile</code></td>
<td>(Local) <code>-l</code> <code>wugstatdata.log</code></td>
</tr>
<tr>
<td><code>-osortmode</code></td>
<td>(Local) <code>-o</code> <code>ascend(descend)</code></td>
</tr>
<tr>
<td><code>-rreport</code></td>
<td>(Local) <code>-r</code> <code>detail export</code></td>
</tr>
<tr>
<td><code>-tmaptitle</code></td>
<td>(Local) <code>-t</code> <code>maptitle</code></td>
</tr>
</tbody>
</table>

Note  ñëêµò ¿µµí `WhatsUp Gold`  ½ø ñëêµò  ñëêµò  `wugstat.exe`  ñëêµò  ñëêµò  `wugstat.exe`  ñëêµò  ñëêµò  `wugstat.exe`  ñëêµò

User's Guide

WhatsUp Gold
(Examples)

```bash
wugstat -mBoston1.wup
```

```bash
wugstat -mBoston1.wup -s20010301 -e20010331
```

**Return Codes**

```bash
wugstat [ Example ]
```

```
1 : [ Example ]
0 : [ Example ]
```

**Performance Graphs**

```
(Creating Performance Graphs)
```

**Note**

```
Reports Performance Graphs Microsoft ODBC ODBC “System Requirements”
```

---

**User’s Guide**

WhatsUp Gold
(Graph Options)

Performance Graphs  

-  
-  
-  
-  
-  
-  
-  

(Creating a Graphs)

1  

-  
-  
-  

Note  

Ctrl  

Performance Graphs  

User's Guide  

WhatsUp Gold
Job Name  report jobs  Description  Do Report  

Report job  Report Job  

2  Reports Type  (performance)  “Sample Performance Graphs”  

3  Date Range  , Start Date  End Date  

User’s Guide  

WhatsUp Gold
Custom, Start, End Date. yyyymmdd.

4 Data Source: wugstatdata.tab, ST-yyyy-mm-dd.tab. Criteria: Contains, Start Date, End Date.

Start Date: yyyy-mm-dd. (20020208)

End Date: yyyy-mm-dd. (20020208)

Data Source: wugstats.

5 Sort Order: Ascending, Descending.

6 Zoom Factor.

7 Export Options.

• Export Format.

• Destination.

8 Query Options.

MapName. All maps, contains, search string. Criteria: Contains, Starts with (search expression), Search String.

Search String: (search text, contains, starts with).

MapName: All maps, contains, Search String. Criteria: Contains, Starts with (search expression), Search String.

DeviceName. All devices, contains, Search String. Criteria: Contains, Starts with (search text).

Note: (*) (contains, does not contain, start with)
9  Do Report  

- wks1, wks2, wks9  
- wks10, wks11, wks120  

- wks1, wks10, wks120  

Exporting Records  

Cancel Exporting  

“Sample Performance Graph”  

Note  

All maps or all devices  

Contains  

Search String  

Does not contain  

Starts with  

Does not start with  

Search String.  Search string  

contains  

Search String  

Note  

User’s Guide

WhatsUp Gold
Sample Performance Graphs

Comprehensive Report

(Sample Performance Graphs)
(Viewing, Printing, and Exporting Performance Graphs)

Performance graphs can be viewed, printed, or exported (viewer).

Device list. View the device list (viewer) to view the IP addresses of the devices.

Tool Bar. The tool bar allows you to access various functions such as Export, Export Setup, etc.

Printing Graphs. Print the graphs directly or print the setup.

Exporting Graphs.

1. Export (export).
2. Format (HTML, text, RTF).
3. Destination.
4. OK.
Basic Command Syntax


<table>
<thead>
<tr>
<th>Argument</th>
<th>Details</th>
</tr>
</thead>
</table>
| jobname     | Cstatrpt.ini.file  
|             | jobname jobname . Note: °ÓÖ°Á°Î  
|             | -x argument °Í non-interactive mode . |
| -mmapname   | cstatrpt -mc:\ProgramFiles\WhatsUp
|             | network1.wup . °ÓÖ°Á°Î  
|             | cstatrpt -m"network": network1, network2, network3 . |
| -ddevicename| -d WKS1, WKS2, WKS3 . |
| -Ddateopt   | -D wtd - Current week to date  
|             | td - Today  
|             | lastw - Last week  
|             | mtd - Month to date  
|             | lastm - Last month . |
| -syyyyymmdd | -s yyyyymmdd  
|             | yyyyymmdd  
| -eyyyyymmdd | -e yyyyymmdd  
|             | yyyyymmdd  
| -logfile    | -l logfile  
|             | wugstatdata.log . |
| -osortmode  | -o sortmode  
|             | Ascend; Descend . |
| -report     | -r report  
|             | Wugstatall.rpt - Comprehensive Report  
|             | Wugstatdaily.rpt - Daily (Line Chart)  
|             | Wugstatdow.rpt - Day of the Week (Area Chart) . |
Examples

Example1.
cstatrpt -m*Boston1.wup

Example2.
cstatrpt -m*Boston1.wup -rwugstatdaily.rpt -Dlastm -x

Export File Formats. export tools UI (command line)

Note

User's Guide

WhatsUp Gold
Export File Formats.

- HTML
- Seagate Crystal Reports
- Acrobat (PDF)
- Data Interchange
- Record Style Format (column of values)
- Rich Text
- Comma Separated Values (CSV)
- Tab Separated Values
- Text (ASCII)
- Paginated Text (ASCII)
- Lotus 1-2-3 (WKS)
- Lotus 1-2-3 (WK1)
- Lotus 1-2-3 (WK3)
- Excel 2.1
- Excel 3.0
- Excel 4.0
- Excel 5.0

(Exporting Multiple Report Jobs)

Cstatrpt.exe 8.0
Cstatrpt Avail_Week
Cstatrpt Hour_Week
Cstatrpt foo
Notification (Sending Recurring Notifications)

notification (Recurring notification) can be sent using various methods such as email, SMS, SMTP, WinPopup, TextSpeech, and Recurring Notification. The options are:

- \texttt{up} - sends a notification when an event occurs
- \texttt{down} - sends a notification when an event occurs
- \texttt{down} - sends a notification when an event occurs
- \texttt{Activity Log} - displays the most recent lines

Recurring Notification can also be set up for periodic notifications.
1. Configure Recurring Notifications. Recurring Notifications

2. Enable Recurring Notifications.

3. Add Add/Edit WhatsUp Reports.

4. notification notification.

5. User's Guide

WhatsUp Gold
6 Time Period: Change 7 days a week, 24 hours a day.

Day of Week: 7 days a week.

Time of Day: 24 hours a day.

• Between 0000 to 2400.
• Not between 0000 to 2400.

Note: Between Not Between 0000 to 2400.

Include UP count.
Include UP names.
Include DOWN count.
Include DOWN names.

Include last n lines of log file.

Message format. WhatsUp Gold

User’s Guide
8 OK notification, WhatsUp Gold notification, Recurring Report.

9 OK notification, Recurring Report.
11  (Working from a Web Browser)

...remote mapping, monitoring, notification (access)

WhatsUp Gold (Setting Up the WhatsUp Gold Web Server)

WhatsUp Gold, WhatsUp Gold ...Windows NT service"

1  Configure, Web Server, General

2  Enable Web Server
3 Enable Web Configuration

4 Enable Web Configuration

5 Enable Sounds

6 Limit Size

7 OK
(Making Maps Available for Web Viewing)

WhatsUp Gold can make network maps available for web viewing. To do this, you need to configure your program to point to a web server. First, configure the web server by selecting "Setting Web Server Access" in the program's properties. Then, configure the program to point to the web server. This can be done by selecting "Web Server" in the program's properties.

- Select "Web Server" in the program's properties.
- In the "Map Directory", select the directory where the maps are located.

Finally, make sure the maps are visible by selecting "Start" from the program's properties.
(Setting Web Server Access)

• **WhatsUp Gold** °èÁ¤¼³Á¤Çϱâ ID °¡Áö À§ÇÑ °Î¿©ÇÒ °èÁ¤Àº ¹æ¹ýÀÌ ÀÖ½À´Ï´Ù.

• ³ºÀ­°èÁ¤ À¥ »ç¿ëÀÚ IP °¡Áö, IP °¡Áö (set)°¡Áö À§ÇÑ °èÁ¤Àº ¹æ¹ýÀÌ ÀÖ½À´Ï´Ù.

( Default User Accounts for the Web Server)

**WhatsUp Gold** °èÁ¤¼³Á¤Çϱâ ID °¡Áö, °¡Áö °Î¿©ÇÒ °èÁ¤Àº ¹æ¹ýÀÌ ÀÖ½À´Ï´Ù.

• °¡Áö ID°¡Áö admin() °¡Áö, WhatsUp Gold °èÁ¤ Àº ¹æ¹ýÀÌ ÀÖ½À´Ï´Ù (admin).

• °¡Áö ID°¡Áö guest() °¡Áö, WhatsUp Gold °èÁ¤ Àº ¹æ¹ýÀÌ ÀÖ½À´Ï´Ù (guest).

• °¡Áö ID°¡Áö guest() °¡Áö, WhatsUp Gold °èÁ¤ Àº ¹æ¹ýÀÌ ÀÖ½À´Ï´Ù (disable).

(Setting Up User Accounts for the Web Server)

**WhatsUp Gold** °èÁ¤¼³Á¤Çϱâ ID °¡Áö, °¡Áö °Î¿©ÇÒ °èÁ¤Àº ¹æ¹ýÀÌ ÀÖ½À´Ï´Ù.

1 **Configure** -> Web Server -> Users -> User Accounts -> Web Server.

3 Add User (사용자 추가).

4 Add User (사용자 추가), ID를 입력한 후 확인을 클릭합니다.

5 Username (사용자 이름), ID를 입력한 후 확인을 클릭합니다. 사용자 권한 설정을 39 더 참조 하십시오.

6 Password (사용자 암호), ID를 입력한 후 확인을 클릭합니다. 사용자 권한 설정을 39 더 참조 하십시오.


Selected Maps >> Selected Maps
Available Maps >> Selected Maps

OK >> 'Delete'

Note: "WhatsUp Gold Web Display".

Configure Program: notifications, Ping, Traceroute.
Configure Users: notifications, Ping, Traceroute.
Configure Reports: notifications, Ping, Traceroute.

Note: Map
Lever Security Setting

(Selecting Map Level Security Settings)

1 Users, Ping, Traceroute.
2 Ping, Traceroute (+), Ping, Traceroute.
3 Ping, Traceroute (Map Level Security Settings).

4 Map Level Security Settings

5 WhatsUp Gold Automatically save changes to users from web interface

6 OK

Note: WhatsUp Gold ID: Configure -> Web Server -> General, Enable Web Configuration

IP (Setting Web Access by IP Address)

2 **Granted Access**.

3 **Add**. "Deny Access On".

   - **Group of Computers**.
   - **IP Address** 255.255.255.0.
   - **Subnet Mask** 255.255.255.0.
   - **IP Address** 156.21.50.0.
   - **Subnet Mask** 255.255.255.0.
   - **Group of Computers**.
   - **IP Address** 156.21.50.1 ~ 156.21.50.254.

4 **OK**.

5 **IP Security**.

   - **OK**.

---

1 **IP Security**.

2 **Add**. "Grant Access On".

   - **Group of Computers**.
   - **IP Address** 255.255.255.0.
   - **Subnet Mask** 255.255.255.0.
   - **Group of Computers**.
   - **IP Address** 156.21.50.0.
   - **Subnet Mask** 255.255.255.0.
   - **Group of Computers**.
   - **IP Address** 156.21.50.1 ~ 156.21.50.254.

3 **OK**.

4 **IP Security**.
**Enable Web Security**

- **Users**
  - **ID**

**IP Security**

- **Edit**
  - **Remove**

---

**Logging On to the Web Server**

1. **Address** (URL) 
   - WhatsUp Gold
   - monitor1.ipswitch.com
   - http://monitor1.ipswitch.com:8081

**Note**

- Configure -> Web Server -> General
  - Enable Web Server

- IP Security
  - (Configure -> Web Server -> IP Security)

---

**User’s Guide**

**WhatsUp Gold**
WhatsUp Gold の機能（WhatsUp Gold Web Display）

WhatsUp Gold の機能には、Top View、Map View、Summary View、Device view、Activity view、Top View（Top View）、Map View（Map View）、Summary View（Summary View）、Device view（Device view）、Activity view（Activity view）があります。 وكل هذه المنصات يمكن تخصيصها وتعديلها لتناسب احتياجات المستخدم.

Top View: Top View 4つのビュー（Top View）、Map View、Summary View、Device view）を使用して、ネットワークの全体像を確認できます。 Help のリンクからユーザーズガイドを読むことができます。

Map View: Top View のビューを使用して、ネットワークの全体像を確認できます。 Help のリンクからユーザーズガイドを読むことができます。

Text Listing: Configure -> Web Server -> General -> Enable Graphical Maps
Maps


Device View.

WhatsUp Gold Statistics Window.
**Summary View.**

<table>
<thead>
<tr>
<th>Name</th>
<th>Type</th>
<th>Polls Responded</th>
<th>Missed</th>
<th>Down time</th>
<th>Period</th>
<th># Alerts</th>
<th># delay</th>
<th>delay delay</th>
</tr>
</thead>
<tbody>
<tr>
<td>SVN1</td>
<td>ICMP</td>
<td>1151</td>
<td>0</td>
<td>0%</td>
<td>0</td>
<td>165:20</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td>SVN2</td>
<td>HTTP</td>
<td>1151</td>
<td>0</td>
<td>0%</td>
<td>0</td>
<td>165:20</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td>SVN3</td>
<td>SMTP</td>
<td>1151</td>
<td>0</td>
<td>0%</td>
<td>0</td>
<td>165:20</td>
<td>0</td>
<td>0</td>
</tr>
</tbody>
</table>

**Detail View.**

WhatsUp Gold is a network monitoring tool that allows you to monitor network performance and troubleshoot issues. It provides detailed views of network performance, including summary and detail views. The summary view provides a high-level overview of network performance, while the detail view offers more granular information about specific network components.

![WhatsUp Gold Interface]

**User's Guide**

WhatsUp Gold
Log View. Log View 追跡ログ画面  Activity Log Page  活動ログページ  Activity Log 画面。Activity Log 視覚化ページ。Activity Log 画面。Log View 画面。Activity Log 画面。

  (Setting Web Colors)

   Configure   Web Server 画面   Colort Settings 画面   Current Item Color 画面   Current Item Color 画面。Configure Web Server 画面。Colort Settings 画面。Current Item Color 画面。Current Item Color 画面。

Colors

Colors 画面上。Current Item Color 画面上。Current Item Color 画面上。Current Item Color 画面上。
What's Up Gold (Customizing Your What's Up Gold Web Site)

Note

7.0 What's Up Gold allows you to customize your web site. To customize your web site, open 'Web' directory of Ipswitch's Templates Archive | 'Classic'. TopView.asp file contains all header, footer and customization information. To customize your web site, open HTML file TopView.asp.

You can customize your web site by editing HTML file. Open HTML file and add your custom content. You can use script code, `<%APPLICATION_SETTINGS% MAIN_TITLE>`, “What's Up Gold” and other tags.

What's Up Gold allows you to customize your web site by editing HTML file. You can use script code, `<%APPLICATION_SETTINGS% MAIN_TITLE>`, “What's Up Gold” and other tags.

Note

Ipswitch's Templates Archive | 'Classic'. TopView.asp file contains all header, footer and customization information. To customize your web site, open HTML file TopView.asp.

13 SNMP Devices (Monitoring SNMP Devices)

Simple Network Management Protocol (SNMP) is a protocol for monitoring and managing network devices, and WhatsUp Gold supports SNMP for device monitoring. SNMP is used to communicate with agents (SNMP devices) to collect performance and configuration data. WhatsUp Gold can also send traps (SNMP notifications) to a management system.

WhatsUp Gold SNMP (SNMP Implementation in WhatsUp Gold)

WhatsUp Gold supports SNMP Version 1 and Version 2c. It can be configured through the SNMP Graphing Utility or by using the Configure-> Monitors&Services -> “SNMP Monitoring” feature.

Note

- SNMP supports SNMP Version 1 and Version 2c.
- The SNMP Graphing Utility and SNMP Monitoring can be configured through the Tools -> Net Tools -> SNMP menu.
- Configure-> Monitors&Services -> “SNMP Monitoring”.

User's Guide

WhatsUp Gold
SNMP Graph Utility

- SNMP (trap): Enables event notifications.
  - Event Log: Enables logging of alerts.
  - Enable Logging: Enables logging of specific events.
  - WhatsUp Gold notification: Notifies via Pager, Beeper, Group, SMTPMail, Sound, WinPopup, or Voice.

SNMP (SNMP Overview)


SNMP agent: A software component that implements SNMP.
MIB (Management Information Base): A standard format for storing and retrieving management information.
SNMP çÁ·ÎÅäÄÝÀº MIB ¿Í ÇÔ²², Á¦Àۻ簡 °¢±â ´Ù¸¥ µð¹ÙÀ̽ºµé¿¡ ´ëÇÑ ³×Æ®¿öÅ© °ü¸®Á¤º¸
(Network management information)¸¦ ÀÐ°í ¼öÁ¤Çϴ ǥÁؾÈÀ» Á¦°øÇÕ´Ï´Ù. SNMP ¸¦ ±¸Çö ÇÏ´Â ¸ðµç ÀÀ¿ëÇÁ·Î±×·¥Àº ÁöÁ¤µÈ µð¹ÙÀ̽ºÀÇ MIB µ¥ÀÌÅÍ¿¡ Á¢±ÙÇÒ ¼ö ÀÖ½À´Ï´Ù. SNMP ¿¡ ´ëÇÑ ÀÚ¼¼ÇÑ ³»¿ëÀº RFC(Request for Comments) 1157À» ÂüÁ¶ÇϽʽÿÀ. ¿¹¸¦, MIB¿¡ ´ë ÇÑ ÀÚ¼¼ÇÑ ¼³¸íÇÕ´Ï´Ù. RFC 1213À» ÂüÁ¶ÇϽʽÿÀ.

Note
IETF(Internet Engineering Task Force)¸¦ ¿¹¸¦ ÀÎÅÍ³Ý Ç¥ÁؾÈÀ» . ¿¹¸¦ RFCS (Request for Comments)¸¦ ¿¹¸¦ ÀÎÅÍ³Ý . ¿¹¸¦ µé¾î, RFCs¸¦ º¼ ÀÖ½À´Ï´Ù. www.ietf.org/rfc.html. ¿¹¸¦ ÀÎÅÍ³Ý .

MIB (Management Information Base)

MIB çÁ·ÎÅäÄÝÀº °³Ã¼µéÀ» °¡Áö°í ÀÖ½À´Ï´Ù. Åë»ó MIB¥±·Î ºÒ¸®´Â ÀÎÅÍ³Ý TCP/IP MIB ¿¡, TCP/IP çÁ·ÎÅäÄÝÀº °³Ã¼µéÀ» Á¤ÀÇÇÏ°í °¢ °³Ã¼¿¡ ´ëÇÑ Ç¥ÁØ Çü½ÄÀ» Á¦°øÇÕ´Ï´Ù. ÀÌ ¼½¼Ç¿¡´Â MIB¿¡ ´ëÇÑ °³¿ä¸¸À» ¼³¸íÇÕ´Ï´Ù. ÀÚ¼¼ÇÑ ³»¿ëÀº, RFC 1213À» ÂüÁ¶ÇϽʽÿÀ.

MIB¿¡ çÁ·ÎÅäÄÝÀº °³Ã¼µéÀ» “°³Ã¼ Æ®¸®(object tree)”¸¦ ÀÎÅÍ³Ý . ¿¹¸¦ ÀÎÅÍ³Ý ., MIBII ¿¡ ºÒ¸® ºÒ¸® ÀÎÅÍ³Ý .

• system - °³Ã¼ µé¾î, sysDescr(description), sysContact(person responsible), sysName(device name)
• interfaces - Ethernet çÁ·ÎÅäÄÝÀº, point-to-point links çÁ·ÎÅäÄÝÀº, ifDescr(name), ifOperStatus(status), ifPhysAddress(physical address), ifInOctets, ifOutOctets(œçëç ÀÇÇØ octet çÁ·ÎÅäÄÝÀº .
• ip - °³Ã¼ µé¾î, IP çÁ·ÎÅäÄÝÀº, ipRouteDest(the destination), ipRouteNextHop(the next hop of the route entry) .

User's Guide

WhatsUp Gold
• (tcp, udp, icmp, snmp, egp) ¹Ýµå½Ã SNMP agent ³ª manager ¼ÒÇÁÆ®¿þ¾î°¡ SNMP agent¸¦ ñë²² Á¦°øÇϰí ÀÖ½À´Ï´Ù.

SNMP Agent or Manager

SNMP Á¤º¸¸¦ ¹Ýµå½Ã SNMP agent ³ª manager ¼ÒÇÁÆ®¿þ¾î°¡ SNMP agent¸¦ ñë²² Á¦°øÇϰí ÀÖ½À´Ï´Ù. Windows 2000, 98, 95, Me ¼ÒÇÁÆ®¿þ¾î°¡ SNMP agent¸¦ ñë²² áê¼ ±âŸ ±â±³Æ®¿öÅ© IP ¼ÒÇÁÆ®¿þ¾î°¡ SNMP agent¸¦ ñë²² áê¼ ±â±³Æ®¿öÅ©.
SNMP Operations

SNMP operations allow you to manage and monitor network devices. The following operations are performed by the SNMP agent:

- **Get**: Allows you to read the values of managed objects.
- **Get next**: Provides the next value of a managed object.
- **Set**: Enables you to change the value of a managed object.
- **Trap**: Sends traps (notifications) to an SNMP manager.

SNMP agent communicates with the SNMP manager through the UDP protocol. SNMP agents use the following ports:

- **161**: For SNMP versions 1 and 2c.
- **162**: For SNMP version 3.

SNMP Traps

SNMP traps are notifications sent to the SNMP manager. The following traps are generated by the SNMP agent:

<table>
<thead>
<tr>
<th>Trap #</th>
<th>Trap type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td>Cold start</td>
<td>Cold start trap: Device starts operating normally.</td>
</tr>
<tr>
<td>1</td>
<td>Warm start</td>
<td>Warm start trap: Device starts operating normally.</td>
</tr>
<tr>
<td>2</td>
<td>Link down</td>
<td>Link down trap: Link is down.</td>
</tr>
<tr>
<td>3</td>
<td>Link up</td>
<td>Link up trap: Link is up.</td>
</tr>
<tr>
<td>5</td>
<td>EGP neighbor</td>
<td>EGP neighbor loss trap: EGP neighbor lost.</td>
</tr>
</tbody>
</table>

SNMP operations and traps are essential for network management and monitoring. They help in troubleshooting and ensuring network reliability.
Enterprise specific traps

SNMP specification

enterprise specific traps

(trap)

enterprise specific traps

MIB

MIB ¥± Ç¥ÁØ¿¡¼­ Á¤ÀÇµÈ SNMP °´Ã¼¸¦ °¡Áö°í ÀÖ½À´Ï´Ù.

³×Æ®¿öÅ©°¡ RFC-ȣȯ MIB ÆÄÀÏÀ» Á¦°øÇÏ´Â º¥´õ(vendor)¿¡¼­ ³ª¿Â µð¹ÙÀ̽º¸¦ °¡Áö°í ÀÖ ÀÙºÁ®ÇÑ MIB ¿Í trap ·¥ ÀÖ½À´Ï´Ù.

MIB Extractor¸¦ ½ÇÇàÇÏ·Á¸é, ´ÙÀ½°ú °°ÀÌ ÇÕ´Ï´Ù.

Note MIB Extractor “failed to open file” À̶ó´Â ¿¡·¯¸¦ ¹ÝȯÇÑ´Ù¸é, »ç¿ëÇϰí ÀÖ´Â MIB ¿Í Import "dependency"°¡Áö°í ÀÖ»çÇØ¾ßº¥´õ¿¡¼­ Á¦°øÇÑ MIB ÆÄÀÏÀÇ Import "dependency"°¡Áö°í ÀÖ½À´Ï´Ù.
SNMP (Viewing SNMP Object)

SNMP is a protocol for managing network devices. SNMP agent sends and receives Get and Set requests in the network. SNMP manager requests information from the SNMP agent.

1. Tools, Net Tools, SNMP. SNMP is a protocol for managing network devices. SNMP agent sends and receives Get and Set requests in the network. SNMP manager requests information from the SNMP agent.

2. Address, SNMP. IP addresses are used to identify the network devices. What is the IP address?

3. Community, SNMP. Community is used to identify the network devices. Community "public".

4. What, SNMP. What is the identifier? What is the MIB? (tree view)
SNMPLEC ™ SNMP Object Selector

Object ID: 1.3.6.1.2.1.21.6
Instance: 1.3.6.1.2.1.1.1

Note What “sysinfo” “system” identification is.

ifPhysAddress. Get Get the ifPhysAddress.
Get Next. Get Next Get the next SNMP agent.
Get Next, What, MIB, Get All Subitems.

Get All Subitems. What, MIB, Get Next, What, MIB.

Monitor. SNMP Graphing Utility, What, MIB, Get All Subitems.

Delay (1000 milliseconds). SNMP.

Start SNMP Viewer.
Configure Interface state colors

<table>
<thead>
<tr>
<th>Interface State</th>
<th>Color</th>
</tr>
</thead>
<tbody>
<tr>
<td>up</td>
<td>red</td>
</tr>
<tr>
<td>down</td>
<td>green</td>
</tr>
<tr>
<td>disabled</td>
<td>blue</td>
</tr>
</tbody>
</table>

SNMP Utility

- Monitor Counters

MIB Viewer

SNMP Graph Utility

Table

- ARP Table
- Address Table
- Route Table
Interface Table – “Interface Table”

### SNMP Functions

- **Tool**: SNMP Viewer
- **File**: SNMP Viewer New
- **Host Name**: IP
- **Community**: SNMP
- **Timeout**: milliseconds

### SNMP (Device SNMP Info)

- SNMP Viewer
- SNMP Viewer
- **Host Name**: IP
- **Community**: SNMP
- **Timeout**: milliseconds

### MIB (MIB Viewer)

- SNMP MIB
- View MIB
- “walk”
SNMP かかわりのジョーダン


SNMP かかわりのジョーダン (object identifier) かかわりのジョーダン

MIB View かかわりの SNMP かかわりのジョーダン かかわりのジョーダン. Monitor かかわりのジョーダン.

ARP Table

Table かかわりの ARP Table かかわりのジョーダン.

Address Resolution Protocol(ARP) Table かかわりの JO. IP かかわりのジョーダン かかわりのジョーダン かかわりのジョーダン かかわりのジョーダン. Monitor かかわりの JO. ARP Table かかわりのジョーダン. IP かかわりのジョーダン.

ARP Table かかわりの JO. ARP かかわりのジョーダン かかわりのジョーダン かかわりのジョーダン. Monitor かかわりの JO. ARP Table かかわりの JO. IP かかわりのジョーダン かかわりのジョーダン かかわりのジョーダン. IP かかわりのジョーダン かかわりのジョーダン (ARP かかわりの JO). Monitor かかわりの JO. IP かかわりのジョーダン かかわりのジョーダン かかわりのジョーダン. Monitor かかわりの JO. IP かかわりのジョーダン かかわりのジョーダン かかわりのジョーダン. Monitor かかわりの JO. ARP Table かかわりの JO.
ARP Table:

Index: MIB ifTable (ifIndex) IP : 156.21.50.5
Address: 156.21.50.5 IP
Physical Address: Ethernet 0060:8071:6fc0
Type: RFC1213 1156

Address Table:

Table Address Table IP
IP Table 0 0.0.0.0
1 191.32.134.193 00000000346b
2 203.233.207.222 000000000000
Mask 0 0.0.0.0

Address: 156.21.50.5
Index: MIB ifTable (ifIndex) IP
Mask: 1 0.0.0.0
Bcast: IP 地址 IP 广播 IP 广播 

ReasmMazSize: IP 地址 IP 广播 IP 广播 

RFC1213 1156 

Route Table

Table 锯齿形 Route Table 锯齿形 

Dest Address. IP 广播IP 广播 IP 广播IP 广播 

Index. 锯齿形 (hop) 锯齿形 

User’s Guide 锯齿形 

WhatsUp Gold 锯齿形
### Interface Table

<table>
<thead>
<tr>
<th>Metric1-Metric4</th>
<th>Metric1</th>
<th>Metric2</th>
<th>Metric3</th>
<th>Metric4</th>
</tr>
</thead>
<tbody>
<tr>
<td>Metric1</td>
<td>Metric2</td>
<td>Metric3</td>
<td>Metric4</td>
<td></td>
</tr>
<tr>
<td>Metric1</td>
<td>Metric2</td>
<td>Metric3</td>
<td>Metric4</td>
<td></td>
</tr>
<tr>
<td>Metric1</td>
<td>Metric2</td>
<td>Metric3</td>
<td>Metric4</td>
<td></td>
</tr>
<tr>
<td>Metric1</td>
<td>Metric2</td>
<td>Metric3</td>
<td>Metric4</td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>NextHopAddr</th>
<th>Next Hop Address</th>
<th>(hop)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Type</td>
<td>(1)=other, (2)=invalid, (3)=direct, (4)=remote</td>
<td></td>
</tr>
<tr>
<td>Proto</td>
<td>(1)=other, (2)=local, (3)=netmgmt, (4)=icmp, (5)=egp, (6)=ggp, (7)=hello, (8)=rip, (9)=es-is, (10)=Ciscolgrp, (12)=bbnSpflgp, (13)=oigp</td>
<td></td>
</tr>
<tr>
<td>Age</td>
<td>“too old”</td>
<td></td>
</tr>
<tr>
<td>Mask</td>
<td>IP mask</td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Metric5</th>
<th>metric.</th>
</tr>
</thead>
</table>

**Info:** 0 0 0 0

RFC1213 1156
Interface Table

Index: MIB ifTable (iIndex) contains a list of interfaces supported by the system. 

Description: The description of the interface, if any, is stored in sysDescr. 

Interface Type: The interface type, such as stack, IP, etc., is stored in sysObjectID. 

Address: The address of the interface, such as IP address, is stored in sysAddr. 

Admin Status: The current administrative status of the interface, such as Up or Down, is stored in sysUpTime. 

Operator Status: The current operational status of the interface, such as Up or Down, is stored in sysUpTime. 

MTU: The maximum transmission unit (MTU) of the interface, such as IP address, is stored in sysUpTime. 

Speed: The speed of the interface, such as 10M or 100M, is stored in sysUpTime. 

Last Change: The last change to the interface, such as a configuration change, is stored in sysUpTime. 

InUCastPkts: The number of higher-layer unicast packets received, such as IP packets, is stored in sysUpTime. 

InUNCastPkts: The number of higher-layer non-unicast packets received, such as IP packets, is stored in sysUpTime. 

InErrors: The number of higher-layer errors received, such as IP packets, is stored in sysUpTime. 

InDiscards: The number of higher-layer packets discarded, such as IP packets, is stored in sysUpTime.
Unknown Protos: unknown protocols

OutUCastPkts: unknown packets sent to multicast group
subnet-unicast higher-level

OutNUCastPkts: non-unicast packets sent to multicast group
non-unicast higher-level

OutErrors: unexpected errors

OutDiscards: packets discarded due to errors

InOctets: framing octets received

OutOctets: framing octets sent

SNMP (Graphing SNMP Values)

SNMP Graphing Utility (line graph)

User's Guide
SNMP Graphing Utility

Starting the SNMP Graphing Utility

SNMP Graphing Utility

• Tools > NET TOOLS > Snmp

SNMP Graphing Utility

SNMP (Adding, Editing, and Deleting SNMP Objects)

User's Guide
1 Edit, Add Item -> SNMP Item. Graph Item Properties.

Graph Item Properties

- Host: 155.21.50.126
- Community Name: public
- Item: 1,3,8,1,2,1,2,1.10
- Instance: 3
- Line width: 1
- Color: Green
- Scale: 0.01

2 Host, SNMP. IP.

3 Community Name, "public".

4 Item, Instance, SNMP. MIB (customizing).

5 Absolute values.
Absolute values, ifOutOctets, SNMP... Absolute values. Absolute values, ifOutOctets, SNMP... Absolute values.

AutoScale. AutoScale, SNMP... AutoScale. Scale. Scale, SNMP... Scale.

Bytes to bits. Bytes to bits, SNMP... Bytes to bits. Bytes to bits, SNMP... Bytes to bits.

Reset values. Reset values, SNMP... Reset values. Reset values.

Line width. Line width, SNMP... Line width.

Color. Color, SNMP... Color.

Scale. Scale, SNMP... Scale. Scale.

Rate per Second. Rate per Second, SNMP... Rate per Second. Rate per Second.

6 SNMP... SNMP. SNMP.

(Viewing Item Values)

SNMP... raw data. Legend, Edit, View Item Values.
“View Item Values” SNMP Title bar.

Time. Value.

Diff. Reported.

Reported. Item Properties, Graph Accumulator Properties, Graph Timer Properties. Absolute Value Bytes to bits Rate per second. Bytes to bits Rate per second (Time Diff)
Time Diff. (milliseconds)

Refresh

(Editing Item Properties)

1. 
   - (legend)
   - Edit Item Properties
   - Properties

Graph Item Properties

2. OK
(Deleting Items from the Graph)

1. File  Edit  Delete Item.
2. ±×·¡ÇÁ¿¡¼­ Delete .

(Saving and Opening Graph Files)

1. File  Save Graph .
2. ±×·¡ÇÁ ¿­±â .
3. ±×·¡ÇÁ¿­¾î .

(Editing Graph Properties)

“Graph Options”  °³Ã¼µé  (layout), SNMP °³Ã¼¿¡  (interval  ¶Ç´Â frequency), µî·Ï±â·ÏÇÒ ÁöºÎ .

±×·¡ÇÁ  . Graph Options  Properties .
Legend.  

SNMP.  

Interval (seconds).  

Vertical(y-axis). Grid  

Maximum: 150  

Horizontal(x-axis). Grid  

Maximum: 150  

Save window location.  

Record data to. Tab-delimited( )  

Append new data to datafile if it already exits.  

User's Guide

WhatsUp Gold
Date [tab] time [tab] first item value [tab] second item value [tab] …

<table>
<thead>
<tr>
<th>IP</th>
<th>SNMP</th>
<th>[highlight]</th>
</tr>
</thead>
<tbody>
<tr>
<td>[156.21.50.12]:1.3.6.1.2.1.2.2.1.10.3</td>
<td>01/03/2001 11:07:34</td>
<td>103782671006689</td>
</tr>
<tr>
<td>[156.21.50.12]:1.3.6.1.2.1.2.2.1.16.4</td>
<td>01/03/2001 11:07:35</td>
<td>169587431031456</td>
</tr>
<tr>
<td>[156.21.50.12]:1.3.6.1.2.1.2.2.1.16.3</td>
<td>01/03/2001 11:07:36</td>
<td>20678156873944</td>
</tr>
</tbody>
</table>

**SNMP (Receiving SNMP Traps)**

WhatsUp Gold | SNMP | Log | Quick Status->Log | Activity Log | Notification | Voice
|-------------|------|-----|-------------------|--------------|--------------|------
|             |      |     |                   |              |              |      |
SNMP Trap Handler Configure -> Program Options -> Event Servers Configure SNMP Traps Configure. Enable SNMP Trap Handler OK.}

**Note** SNMP agent WhatsUp Gold SNMP WhatUp Gold SNMP SNMP. SNMP WhatsUp Gold 162. SNMP WhatUp Gold SNMP.

3  notifications.

**SNMP Trap Event** (Setting Up SNMP Trap Events)

Event Library SNMP Trap Library. “Adding Events to the Events Library” “Adding Events to the Events Library” WhatsUp Gold SNMP. "Adding Events to the Events Library":

- badVoltage,apc,6,49
- batteryOverTemperature,apc,6,53

Bad Voltage.

1. Event Library SNMP library New.
2. **Display Name.** “Bad Voltage”  

3. **Enterprise/OID.** “apc”  

4. **Generic Type (Major).** “6” – Enterprise Specific.  

5. **Specific Type (Minor).** “49”  

6. **OK.**

---

**SNMP Trap Event** (Assigning SNMP Trap Events to a Device)

Add  

---

**Note**

Bad Voltage  

Events Library  

SNMP Trap  

WhatsUp Gold  

Event/SNMP Traps
SNMP Trap Events Notification (Setting Up Notifications for SNMP Trap Events)

SNMP Trap Events notification WhatsUp Gold.

"Bad Voltage" notification:

1. Enable Alerts.
2 Enable Alerts  Enable Logging.

3 Alerts, Add.

“Add Alert”.

4 , Add notifications.

notifications “Defining Notifications”. 

5 On Event.

Select Events.
6  OK  Alerts  OK.

7  Notification  Time Period.

8  OK  notification  notifications.

9  Alerts, OK  Alerts.

(Viewing Trap Log Entries)

SNMP  (Monitoring SNMP Service)

1  SNMP  :

Note  Properties  Services.
2 Services

3 Services to Monitor SNMP. Add Service to Monitor SNMP.

4 OK

Note SNMP (*).
13 Using Network Tools (Using Network Tools)

WhatsUp Gold provides several tools for network monitoring.

**Tools**

- **Net Tools**

  - Info
  - Time
  - HTML
  - Ping
  - Traceroute
  - Lookup
  - Finger
  - Whois

  These tools allow you to gather information about network devices such as:

  - **Info**: Provides general information about a host.
  - **Time**: Displays the current time and allows you to connect to a remote time server.
  - **HTML**: Sends an HTML request.
  - **Ping**: Sends an Ping request.
  - **Traceroute**: Sends traceroute information.
  - **Lookup**: Performs a reverse DNS lookup.
  - **Finger**: Sends a finger request.
  - **Whois**: Performs a whois lookup.

**Info, Ping, Traceroute, and Throughput**

- "List view" (list format)
- "Report view" (textual format)

**Tools**

- **System Info**
- **SMTP**
- **SNMP**
- **WinNet**
- **Throughput**
- **System Info**

**Parameter**

- **IP Addresses**
- **Aliases**
- **Domain Servers**

- **Official Name**
- **Domain Name**
- **Record Created**
- **Contact**

**Retrieve general information about a host.**
- LDAP - クレジット 格安 倍 倍 倍 倍
- Quote - quote quotations
- Scan - サンプル IP 2 2 Creating Network Maps
- SNMP - SNMP(Simple Network Management Protocol) 12 Monitoring SNMP Devices
- WinNet - Windows Network
- Throughput - トータル
- System Info - 情報を取得

(Using Format, Copy, and Print Functions)

Undo, Cut, Copy, Paste, Delete, Select All

Ping, TraceRoute, Throughput Report View, Edit, info, List view

(Printing Results)

File, Print
(Display Device Information) Info Tool

Info 💡, ☑️, ▶️, ❌, ✗, ✗, IP ✗, ✗, ❌ (Whois ❌) ☑️, ☑️, ☑️, ☑️, ☑️, Info ☑️, ☑️, ☑️, Info ☑️, ☑️, Info ☑️.

Info ☑️, ☑️, ☑️, ☑️, ☑️, ☑️, Info ✗, ✗, ✗, Info ✗, ✗, Info ✗.

Lookup ✗ Whois ✗ (query) ✗, ✗, ✗, ✗, ✗, (ping) ✗, ✗, ✗, ✗, ✗, ✗, ✗, ✗.

Info ✗ (query) ✗, ✗, ✗, ✗, ✗.

1 Tools ☑️, Net Tools ☑️, Info ☑️, Info ☑️, Info ☑️.

2 Host Name or IP ☑️, ☑️, ☑️, ☑️, ☑️, ☑️, ☑️.
   ✗, ✗, ✗, ✗, ✗, (fully qualified host name) ☑️, ☑️, ☑️, ☑️, whitehouse.gov ☑️, ☑️, ☑️.

3 Start ☑️, ☑️.
   ✗, ✗, ✗, ✗, ✗, ✗.

Start ☑️, ☑️, Stop ☑️, ☑️, Stop ☑️, ☑️, Clear ☑️, ☑️, ☑️, ☑️.
HTML Tool

- **HTML**
  - **RAW**
  - **formatted HTML**

**Tools**

**Net Tools**

**HTML**

**URL (Uniform Resource Locator)**

- **RAW**
- **formatted HTML**

**Start**

- **Stop**

**Clear**
(Synchronizing Time)

Time 

• Time  ÅøÀ» °ø¿ëÀ¸·Î Ȱ¿ëµÇ´Â ¼­¹öµé¿¡ ˚ëÇØ »çÀü¿¡ Á¤ÀǵÈ ¿£Æ®¸®¸¦ Á¦°ø ÇÕ ´Ï´Ù.
• GMT  ¿¡¼­ ¿É¼Â (offset, Â÷°¨ ¼ýÀÚ) À» Æ³Á¤ÇÔÀ¸·Î½á ¿ø°Ý ŶÀÓ ¼­¹ö¿Í µ¿±âÈ­ÇÏ·Á¸é , :
• (Server Name, Time, Difference, Offset, and Error Code)  ¿¡¼­ ÀÇ ÀÌ ¿É¼ÇÀ» ³ªÅ¸³À´Ï´Ù .

Note  Time ÅøÀº °ø¿ëÀ¸·Î ³¯Â¥ ¿¡¼­¹öµé¿¡ ˚ëÇØ »çÀü¿¡ Á¤ÀǵÈ ¿£Æ®¸®¸¦ Á¦°ø ÇÕ ´Ï´Ù .

1 Tools  ¿¡¼­ , Net Tools  ¿¡¼­  Time  ¿¡¼­  Time  ¿¡¼­  ¿¡¼­ .
2 Time Server  ¿¡¼­ ,  (query)¿¡ ¿¡¼­ ÀÇ IP  ¿¡¼­ ÀÇ ¿¡¼­ . ¿¡¼­ ÀÇ IP ¿¡¼­ ÀÇ ÀÇ .
3 Synch Clock to Remote Time ¿¡¼­  ¿¡¼­  ¿¡¼­ (offset, ¾çÀ̳ª À½ÀÇ ½Ã°£)¿¡ ¿¡¼­ ÀÇ ¿¡¼­ ÀÇ .
4 ( ) Offset  ¿¡¼­  ¿¡¼­  GMT  ¿¡¼­ (offset, ¾çÀ̳ª À½ÀÇ ½Ã°£)¿¡ ¿¡¼­ ÀÇ ¿¡¼­ ÀÇ .
5 Start  ¿¡¼­  ¿¡¼­ .

• Clear  ¿¡¼­  ¿¡¼­  ¿¡¼­ .
• Remove

Time Server, Start, Stop, Clear, Sync Clock To Remote Time

Time Server, IP
Start

Update Time from Server

Sync Clock To Remote Time
Start Monitoring This Item:

Stop Monitoring This Item:

Start Monitoring All This Item:

Stop Monitoring All This Item:

Remove:

(Ping Tool)

Ping:

Tools, Net Tools, Ping:

Hostname or IP:

Pinging a Host:

User's Guide

WhatsUp Gold
3 TCP/IP, ICMP, Novell NetWare, IPX, Windows, NetBEUI.

**Note** IPX, Microsoft NWLink IPX/SPX, NWLink IPX/SPX, "System Requirements".

4 Count, Delay (sec), Size, Timeout (ms).

5 Start.

Ping echo request, echo reply. PingPingPing.
User's Guide

Start ¹öưÀ» Stop ¹öưÀ¸·Î Clear ¹öưÀ»

1 Tools ¹öưÀº, Net Tools ¹öưÀº TraceRoute ¹öưÀº TraceRoute ¹öưÀº TraceRoute ¹öưÀº TraceRoute ¹öưÀº.

2 Host Name or IP ¹Ú½º¿¡¼­, °æ·Î ÁßÀû ÇÏ·Á´Â °¢, °ÍÀ» ¹ß»ý ÁöÁ¡ À» µ¥ IP ÁÖ¼Ò¸¦.

3 Maximum. °æ·Î ÀÖ½À´Ï´Ù (hop), °¢ ¶ó¿ìÅÍ¿¡ ÀÌÀü ¶ó¿ìÅÍ¿¡ ¹®Á¦ ¹ß»ý Á¢¼Ó µÈ.

Map Results. ¹Ú½º¿¡¼­, °æ·Î ÇÏ·Á´Â °¢, °ÍÀ» ¹ß»ýÁö¹®Á¦ ¹ß»ý Á¢¼ÓµÈ, WhatsUp Gold ¹Ú½º¿¡¼­, °æ·Î ÇÏ·Á´Â °¢, °ÍÀ» ¹ß»ýÁö¹®Á¦ ¹ß»ý Á¢¼ÓµÈ.
TraceRoute.

- Start
- Stop
- Clear

Map Results.

- Sleepy
- Internic

(Lookup Tool)

Lookup and how to use lookup tool:

- IP address
- Domain name servers (DNS)
- Domain name servers (query)
- IP address

- IP address
- Domain name servers (DNS)
- Domain name servers (query)
- IP address

Lookup query:

2. Host Name, IP Address, Domain name servers (DNS).
3. Domain name servers (DNS).

DNS Server:

- IP address
- Domain name servers (DNS)
- Domain name servers (query)
- IP address

Note:

- Query Type. Returns the following information:

<table>
<thead>
<tr>
<th>Type</th>
<th>Returns the following information</th>
</tr>
</thead>
<tbody>
<tr>
<td>A</td>
<td></td>
</tr>
<tr>
<td>ALL</td>
<td>All information</td>
</tr>
<tr>
<td>CNAME</td>
<td></td>
</tr>
<tr>
<td>HINFO</td>
<td></td>
</tr>
<tr>
<td>MX</td>
<td>The host that acts as the mail exchanger</td>
</tr>
<tr>
<td>NS</td>
<td>The name server for the named zone</td>
</tr>
<tr>
<td>PTR</td>
<td>The host name, if the query is an Internet address; otherwise, a pointer to other data</td>
</tr>
<tr>
<td>SOA</td>
<td>“start of authority”</td>
</tr>
<tr>
<td>ZONE</td>
<td>(ZONE)</td>
</tr>
</tbody>
</table>

Note:

- Lookup (stack) Winsock stack lookup routines.
- DNS Winsock stack routines.
- Query Type. Returns the following information.

<table>
<thead>
<tr>
<th>Type</th>
<th>Returns the following information</th>
</tr>
</thead>
<tbody>
<tr>
<td>A</td>
<td></td>
</tr>
<tr>
<td>ALL</td>
<td>All information</td>
</tr>
<tr>
<td>CNAME</td>
<td></td>
</tr>
<tr>
<td>HINFO</td>
<td></td>
</tr>
<tr>
<td>MX</td>
<td>The host that acts as the mail exchanger</td>
</tr>
<tr>
<td>NS</td>
<td>The name server for the named zone</td>
</tr>
<tr>
<td>PTR</td>
<td>The host name, if the query is an Internet address; otherwise, a pointer to other data</td>
</tr>
<tr>
<td>SOA</td>
<td>“start of authority”</td>
</tr>
<tr>
<td>ZONE</td>
<td>(ZONE)</td>
</tr>
</tbody>
</table>

User's Guide

WhatsUp Gold
Verbose  
DNS  
DN

4  Start  
Lookup  
Stop  
Clear  

(Finger Tool)

Finger  
Finger server  
Finger  
Finger .plan  .project  
Connection not made
Finger ¼­¹ö¿¡ .


2. **Finger String** ® Finger ® IP ® Finger ® IP ® Finger.

3. **Start** ® Finger ® Finger ® Finger ® Finger ® Finger.

---

**Whois Tool**


**Note** NIC(Network Information Center) ® whois.networksolutions.com ® whois.networksolutions.com.
Whois  ¸Ý, ¸Ý Net Tools  Whois  Whois  :

1  Tools  Net Tools  Whois  Whois  

2  Search String  ¸Ý  ¸Ý  ¸Ý  ¸Ý  

3  WAIS Host  ¸Ý  ¸Ý  ¸Ý  ¸Ý  

4  Start  Whois  Whois  Whois  Stop  Whois  

LDAP (LDAP Tool)

LDAP (Lightweight Directory Access Protocol)  ¸Ý  ¸Ý  ¸Ý  ¸Ý  ¸Ý  ¸Ý  ¸Ý  
LDAP  x.500 directory access  (subset)  

LDAP  x.500 directory  

User's Guide  

WhatsUp Gold
LDAP Host

1. Tools, Net Tools, LDAP, LDAP (query), LDAP (query).

2. LDAP, LDAP (query), LDAP (query).

3. LDAP Host, LDAP (query).

4. Start.
Note LDAP ²³± —²²°— çå°—°¢·°µ°¬. 

ÀÌ°æ¿ì¿¡´Â °Ë»ö Ç׸ñÀ» Á» ´õ ¼¼¹ÐÇϰÔ Á¤ÀÇÇÒ Çʿ䰡 ÀÖ½À´Ï´Ù. 

ÁúÀǸ¦ ó¸®ÇÏ´Â µ¿¾È, Start ¹öưÀº Stop ¹öưÀ¸·Î. °ì ä»·ë Start Stop çå°—°¢·°µ°¬. Clear çå°—°¢·°µ°¬ çå°—°¢·°µ°¬. 

Quotations (Quote Tool)

Quote ¹Ýµå½Ã Àüü È£½ºÆ®¸í (fully qualified host name) ÀÔ·ÂÇØ ÇÕ´Ï´Ù (¿¹¸¦ µé¾î, quotes.ipswitch.com ÀÔ·ÂÇÕ´Ï´Ù). 

“It was as true as taxes is. And nothing’s truer than them.” 

Charles Dickens (1812-1870) 

Quotes: 

1 Tools, Net Tools, Quote, Quote, Quote, Quote, Quote. 

 ¿©±â¿¡´Â ¹Ýµå½Ã Àüü È£½ºÆ®¸í (fully qualified host name), quote server, quote, quote server, quote server. 

Start, Stop, Clear

(Scan Tool)

Scan: IP, SNMP (Simple Network Management Protocol)

(SNMP Tool)

SNMP: networks, domains, servers, shares

(WinNet Tool)

WinNet: tools, network items

networks - (groups of networks)
domains - (groups of domains)
servers - 
shares - 

User’s Guide
User's Guide

WhatsUp Gold

all - プリントアウトマクロを参照してください。

3 Start をクリックします。

WhatsUp Gold は、スクリーンの上部中央に "Start" と "Stop" のボタンが表示されます。これらのボタンをクリックすることで、測定の開始と停止が可能です。

3 Start をクリックし、"Stop" をクリックします。Clear をクリックすることで、前の測定のデータがクリアされます。

---

**Throughput Tool**

Throughput を介して、ネットワークのパフォーマンスを確認することができます。このツールは、ネットワークトラフィックの情報に基づいて、パケットの送受信速度を計算します。

1 Tools をクリックし、Net Tools を選択します。 "Throughput" をクリックします。

2 Hostname or IP を選択し、IP アドレスを入力します。 (例: "internic.net")

3 パケットの数、タイムアウト、パケットサイズ、遅延時間などのメトリクスを表示します。

4 Start をクリックします。

Throughput のデータを表示し、Throughput の値を確認します。TCP および ICMP のパケットの検出が可能です。TCP の高速送信は、Echo のエコーを含みます。IP の検出は、ポート 7 を含む。

---

User's Guide

WhatsUp Gold
(milliseconds)।

Start । Stop । Clear । Tools । Net Tools । System Info।

(viewing Local system Information)
• WhatsUp Gold

- System Info
  - IP
  - Netmask

Note: DHCP (Dynamic Host Configuration Protocol) includes Local Hostname, Local IP Address, Domain, Name Server, Default Gateway, IP, and Netmask. IP and Netmask are 0(zero).

User's Guide

WhatsUp Gold